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Introduction

BBLogger is a new managing software for Amateur Radio Stations and Short Wave Listeners.

The program is absolutely free and it can be freely shared withother Radio Amateurs / SWL on
condition it won't be modified in any part.

The program runs on Computers with O.S. Windows 2000 / XP / Windows Vista and with .Net
Framework 2 installed. In case your Computer does not have .Net Framework 2, you can download
it from this Microsoft Official Web Site:
http://www.microsoft.com/downloads/details.aspx?displaylang=it&Family|D=0856eacb-4362-
4b0d-8edd-aab15c5e04f5

The program can run also with Windows 98/ME platforms, on condition that several additional
programs have to be installed: MDAC_TYP.EXE or MDAC_TYP_281.EXE , DCOM98.EXE and
JET40SP8_9XNT.EXE.

These files can be downloaded from the Web Site www.aribusto.it ( click on DAl -> SOFTWARE DAl
-> SCARICA VISUAL DAI ) because they are the same to get Visual DAI working with Windows
98/ME.

At the moment it has not been tested yet with other O.S.

Important Note: all pictures shown have Italian writings, but selecting other languages they'll
turn to the selected language.

Once you have downloaded the ZIP file, you just have to decompress it in a temporary folder or on
the Desktop, then to launch the SETUP.

At the end of the procedure you should have a configuration like this:

[ =B8] R [
@@ﬂ » Computer » COMPAQ(C:) » BBLoggerl018 » = | 45 |l| cerea =)
¥ ¢ = e e S T e @ e = e meeee coaees
. ‘ Organizza aliza ~ [ Esplora E Condivisione I asterizza
Nome Ultima modifica Tipo Dimensione
ARI BB Diplomi | BBLCAT 02/02/2010 23.23 Cartella difile i
: | FilesAward 10/02/2010 21.44 Cartella di file ]
B Documenti FilesDatabase 10/02/2010 2144 Cartella di file |
B Immagini Help 02/02/2000 2312 Cartella difile |
Altro » Souncs 02/02/2010 2312 Cartella difile I
Cartelle i TemporaryFile 06,/02/201015.24 Cartella di file I
| FilesDatabase . | % Adnterop. MMVARILib.... 22/06/2008 20.02 Estensicne dell'ap... 68 KB
Help 4 | BBLconfig 10/02/2010 21.25 Impostazioni di co.. 2KB
| Sounds E]BBlogger 10/02/201010.28 Applicazione 6.242 KB
i Tenpodiie %.J BBloggerUpgrade 28/01/2010 937 Applicazione 93 KB
BBLogger Laboratorio %] BBLSoundblaster.dll 06,/04/2009 14.47 Estensione dell'ap... 52 KB
T — %] BEMaps.dll 28,/01,/2010 9.05 Estensione dell'ap... 2572 KB
Callbook %] BBMapsl.dil 28/01/2010 9.07 Estensione dell'ap... 1811 KB
- %] BBMaps2.dll 28/01/2010 9.09 Estensione dell'ap... 1662 KB
Debug %) BBMaps3.dll 28/01,/2010 9.15 Estensione dell'ap... 2524 KB
Diplomivai %) BEMaps4.dil 09,/02/2010 17.36 Estensione dell'ap... 1514 KB
| Elabar %] BBMapsUSL.dil 28/01/20109.29 Estensione dell'ap... 4,054 KB
B Eite Accees . %] BBMapsU52.dll 28,/01,/2010 9.24 Estensione dell'ap... 3881 KB
| FileDOC |E]| [%]BBEMapsUs3.dil 28/01/20109.31 Estensione dell'ap... 2,903 KB
. File Excel 4 | BBTermcenfig 10/02/2010 14.38 Impostazioni di co... 2KB
File PDF (%[ ICSharpCode.SharpZip... 30/06/2008 12.52 Estensicne dell'ap... 208 KB
File TxT % InteropJRO.dII 04,/06/2008 13.26 Estensione dell'ap... 9 KB
' File Word (% Interop.MMVARILib.dIl  05/12/2008 19.58 Estensione dell'ap... 75 KB
S %] Interop.Werd.dll 18/08/2008 16.31 Estensicne dell'ap... 572 KB
@1 Help 1% MMVARLocx 03/12/2008 15.16 ActiveX Control 460 KB
[._il Help Erglish %] raccd32a.dll 08,/12,/2000 1417 Estensicne dell'ap... 58 KB
[ som || Satlist 03/02/2010 22.24 Documento di testo 1KB
gL ﬂsetupbblcat 25/01/201019.35 Applicazione 837 KB
Tesch _ %] UiExtender.Docking.dll ~ 28/12/2008 20.43 Estensicne dell'ap... 398 KB
FilesAward
i1 Cartella di file
E l Ultima medifica: 10/02/2010 21.44 i




Don't worry if you can't see all the files and sub-folders, the software will create them once you run it

for the first time.

Check also the presence of the following files in the sub-folder FilesDataBase:
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And in the sub-folder FilesAward you should have several MDB files ( files of Access ), related to the

Awards you can manage with this software.

These databases are protected by a password because the content is property of the Authors and it
won't have to be either modified or given to third parts for purposes different than the use with this

program.

If all is OK you can go to: (‘start Software )




Start Software

Now you are ready for first running of the program: the installation procedure creates an icon on your
Desktop. To launch BBLogger just double-click on its icon.

For Windows Vista users: if you encounter problems in getting your software properly working, you
can configure it to be executed in mode compatibility Windows XP.

Click on the BBLogger icon on your Desktop with right button of the mouse and select Properties.
Click on Compatibility and tag the box "Execute the program in mode compatibility for" ->
Windows XP.

After first launch a box will open:

Manca il CALL! Aggiungere un CALL adesso?

| [ nNo

It means: "There isn't a CALLSIGN! Would you like to add one now?"

Don't worry about the language.

The current version of BBLogger starts in English.

Other languages can be selected from menu "Tools". Of course click on YES and another box will
appear:

T User BBLogger &'

OMData | oM Service |

G 1

| OM Data | OM Service

Email

CALLSIGN TZ17ZZZ oM - |

Address
MName Mario i

i SMTP i
Cognome  Rossi
i - Password

Citta Toring

2Q5SL Service
Indirizzo Corso Molise 21

UserMName
ZIPCODE 10151 LOCATOR JM35TC

Password

Nazione ITALY
LoTw Service

RIG Kenwood TS 850 5 UserName

POWER  100W Sikssasl

ANTENNA  Yagi3el. 10/15/20

Fill all the fields of the OM Data form and choose from the list your condition (OM / YL / Clubstation
/ SWL).

In OM Service section put your e-mail address, the server for the outgoing mail (e.g. out.yahoo.com)
and possibly the password you use for e-mail ( some servers, but not all, require it ).

Then you can fill the eQSL and LoTW ID & PWD if you are member.

Save your settings with OK.

Maximize the window and click on LOG in the tool bar and select NEW LOG:




———— e @
Data LOG | MyFavoriteModeBands

Nomedel LOG  PIPPO
MyCALL [ -|
Tipo LOG | HunER: -]

Automatically the program proposes the Callsign you entered in the previous stage, in LOG NAME
you can enter all you want, in LOG TYPOLOGY you can select HUNTER ( the home log ) or
EXPEDITIONER ( if you are going to activate an abbey, a castle, an island, etc. ) or SWL.

According with the typology of your log the features can be different.

The option MY FAVOURITE MODES /BANDS allows to select the bands and the modes you are
going to use for that log. Anyway you can change these choices later.

The program allows to enter more than one User, in case you need to manage different callsigns, like
contest calls, slashed calls, or just someone else's calls you are managing.

[=]

Data LOg | MyFavoriteModeBands

558 , 160m =
cw 0 B0m Wi
RTTY E‘ 40m

S5TV L @] 30m t
PSK31 J0m

QPSK31 17m 4
HELL 15m

THROE 12m

MTE3 - 10m a

Once the log has been created, it has to be filled. If you wish to import your old log from another
managing software be sure to have exported it as ADIF FILE.

Now click on FILE in the left side of the tool bar, then on FILES MANAGER: a window like that in the
picture will open: IMPORT ADIF FILES allows to import an ADIF FILE.

It's possible to set a date range to establish the importation, tagging the box and entering the range
of date. The two options in the bottom allow to correctly identify the Country.

With Automatic DXCC check only QSOs without any doubt about the Country will be imported,
meanwhile the software produces a text file and a secondary ADIF file related to QSOs with
ambiguous Country ( e.g. VP8, used for Falkland, South Shetland, South Georgia, South Orkney,
South Sandwich and Antarctica ).




This secondary ADIF can be examined and imported later under the option Manual DXCC check:
the program proposes all different options for ambiguous prefixes and the user will choose the correct
one, on the base of the QSL card or the previous log.

This operation could be quite long. The automatic procedure will import your data at average speed
of about 1000 QSO per minute, but real sped depends from your processor.

Of course it is possible to check and import your log in one step, selecting the manual check, but that
could be very long.

The windows allow to check the progress of the process and to see the list of the QSOs not imported.

If the comment field of the imported ADIF file contains REFERENCES IOTA, DCI or DAI, they will be
automatically imported in the proper fields of BBLogger.

Of course the references must be written in the correct way, according with those in the databases.

The transfert can be done also with the procedure in Tools > Configuration/Maintenance > Award
Auto Checking.

AN e =

Importa File > LOG | Esporta Log in File | DownLoad File LoTw/eQsl |

[] Filtro Date Qso _
(-]

Data »= [L/09/2009 ~ Options

@ Verifica automatica DXCC Tipo File = [ABIF Log Generic - |

: Rats=s= fEfomE i Verifica manuale DXCC

Log destinazione > | auvR - L ok |

THE ARRL

Process | Qso not imported |

With EXPORT ADIF FILES you can export your files in ADIF format for any purpose.

Tagging Copy to Comment and selecting the Award you can copy the containing of the field of that
Award into the Comment field of the adif file you are going to export.

With File Tipology you can select the kind of file: generic ADIF File for any purpose, or specific
ADIF file for LoTW or eQSL.cc.




EXITE e =

| Importa File > LOG | Esporta Log in File | DownLoad File LoTw/eQsl |
[ ] Filtro Date Qso
| o
Datz == 19/09/2009 =~ Options
["| Copia nei Commenti > [ECA = | Tipo File = [AD]]:Lngﬁene_ric vl
Data <= 19/09/2009 ~ !
Origine del Log > [kauvr - | oK |
" § .
THE AR R'I'; 20Q5L Comment

With DOWNLOAD FILE LoTW / eQSL you can import the credit filed sent by LoTW or eQSL.cc for
the automatic crediting procedure.

The columns of the log sheet can be sorted alphabetically from A to Z or vice-versa from Z to A.

Combination CTRL+Letter allows to place the cursor on first record starting with that letter,
facilitating the seeks.

Of course the column DATE can be sorted from fresher QSO to older one or vice-versa.

It is possible that, despite of the checking procedure, some prefix can be misdecodified, as example
European Russia or Asiatic Russia or Kaliningrad for celebrative prefixes like R750, or maybe with
prefixes belonged to ex U.S.S.R, changed many times and assigned to different Countries, like
Russia and Ukraine.

These changes were not contemporary, so it is possible that in the transition time same prefix has
been used by different Countries. For that we advice to check your log after the conversion to
eliminate these possible mistakes.

If you want to create an Expeditioner log, you have to select EXPEDITIONER from the menu.

You also will have to fill the fields related to the reference number and the kind, as IOTA, DCI, DAI,
and so on: as example the reference NA156 for IOTA:




Data LOG | MyFavoriteModeBands

NomedelLOG  PIPPO

MyCALL [n2uvm -

Tipo LOG |ExpEDITIONER -]

Attivazione NA156 10TA - [ ok
Commenti Isola di Pluto

In the box COMMENTS the user can write a text, as example the name of the island he is going to
activate. For all QSOs this text will be inserted in the field Comment.

WARNING: the Expeditioner logs are necessarily more spartan than the Hunter logs, as
exemple the fields for the Awards are not implemented.

If you merge these logs with your main log you have to consider that! Revise the QSOs and if
necessary, complete them for Awards you usually follow.

Save your settings and go to " Initial Setup




Initial Setup

Before to start you need to do all settings: from menu TOOLS select CONFIGURATION / MAINTENANCE:

[1 Manutenzione-Configurazione Log : IK2ZUWVR |£J

Callbooks |Aggiurnamenti in Rete | Utility I AwardAutuChecking|

I ) No Callbook

|| [[] QRZ.com ( Internet)

Il RA.LC. Cy\RAC\Callbook.exe A m
[[] *.DBF (Ttaly-World) C:\Dati\world.dbf Yz
[ RADAMATO C:\Program Files\RADAMATO\radamato_cfr.mdb 1

e —— — — — —— e e = =

CALLBOOKS allows to set the Callbook from which the software gets the info.

The options are RAC, *DBF and RADAMATO. RAC is Radio Amateur Callbook, DBF is any
callbook in DATABASE format, e.g. WORLDCALL by IKIMTT, and RADAMATO is the italian
callbook by I0OSSH.

For all them you need to give the path, as example D:\, C:\\RAC, with the key "\..." you can explore
the folders and reach the file to hook.

The program will automatically assign the path. If you use Worldcall by IKIMTT you have to follow
this procedure: make a folder called DATI an copy in it the following three files from the CD ROM:
WORLD.BOK, WORLD.NSX and WORLD.INF.

They are in the folder with same name of the CD ROM of IKIMTT. If the fle WORLD.INF is not
present, you can easily make it: open the Notebook and write these two rows: first row: [dbase],
second row: NDX=WORLD.NDX.

Save with the name WORLD.INF. From the web site where you downloaded this software download
the file FLY.ZIP and decompress in the folder DATI. Launch FLY.EXE and in some minutes the file
WORLD.NDX will be created.

This file is an index that speeds up the seeks in the database. Finally rename the file WORLD.BOK
to WORLD.DBF.

If you are not expert on how to do that we advice to use tools like Total Commander, downloadable
on-line. You can also set more than one Callbook.

The program will perform multiple searches.

In this case the search could be slower.




-
(1 Manutenzione-Configurazione Log :

‘; | DATABASE B.MI.KUP| | Preferred Font |

@ Documents in Office (Microsoft)

‘i'_j_'l DATABASE RESTORE ‘ (7 Documents in OpenOffice (Sun) Language = IITALIAH-D v]

| Check Log QRB

I Data >= Data <=
| Check Log FREQ. ] [] Filtro Date Qso = 27/03/2010 ~ 27/03/2010 ~
|  ChecklogTxPwr | Phone-> | 1000 & pigi-> 3001 cw-> 5003 RITY-> 800

[ Check Log DXCC

The section UTILITY allows the BACKUP and the RESTORE of the log, and to select FONT and
LANGUAGE.

The BACKUP is made by compression of the log and the filename contains the date when the
backup was performed ( in format YYYYMMDD ), e.g. BBLBKP_20090301.ZIP.

Of course you can select the folder where the file will be stored. At the end of any session the
program always proposes to activate the backup procedure, and the user can choose if to do that or
not.

The key CHECK LOG QRB allows to check your log and automatically put the QRB of each already
recorded QSO (of course WWLocators have to be correct), the key CHECK LOG FREQ allows you
to automatically revise your log and insert the basic frequencies according with the bands, the key
CHECK LOG TX PWR allows to insert the power of your transmitter in each already recorded QSO,
according with the power you can select for each mode in the boxes in the center of the window. This
new feature has been introduced with the version 1.0.2.0. The key CHECK LOG DXCC allows to
revise your log in order to check the DXCC Country. The program seeks QSOs with stations with
"ambiguous" Callsigns, in other words those prefixes not certainly referred to ONE DXCC Country,
like GB, VP8, TO, nd so on. This utility is very useful for people who already imported the log and
wants to check the accuracy. If you don't want to choose one of the Countries proposed in the DXCC
Country List Box that will open, just click ESC to skip the QSO. After the checks, a text file called
CheckLogError_date and time will be write, and it is available in the FilesLog folder. If the correct
Country is not present amog those proposed, you can force it with the proper procedure (see Insert

QS0)

10



Vi e s T Mt _

|| Callbooks | Utility | AwardAutoChecking | Database Linker
|

Scelta Award > | CANADAWARD -
Data »>= Data <= [
[7] Filtro Date Qso > 15/11/2009 ~ 15/11/2009 ~

CANADAWARD - Canadian Islands
Attenzione ! l'operazione ricalcola e sovrascrive gli indirizzi e nome operatore

The section AWARD AUTO CHECKING is a very useful utility that allows to automatically update
your log on the base of a Callbook, in order to insert info, useful to manage several Awards.

We will examine this utility in the section AWARD MANAGER

Once all settings are made we can examinate the structure of the program going to: | Desktop

11



The Desktop

The desktop is divised in three areas sizeable by the user: the ' L095heetis in the lower area:

3 BBTERM )"“3 LOGGER |

" Nuovo Qso (F2) &, Ricerche (F3) EQSIS - E QsiR - L__fj RAC a}ﬁ Manager | 3| Colonne Log - @ Ricerca REF.

DD-MM-YYYY UTC Time CALLSIGN Mode Band FREQ(Mhz) WAC WAZ ITU DXCC
01-09-2007 | 08.55 IZ2KXC/1/P |SSB  40m |7.000 EU [15 [28 |ITALY
91-09-2007 ©8.54 EASFGK SSB  40m  7.000 EU 14 37 SPAIN
01-09-2007 ©8.54 IZ3LEV/IVZ SSB 46m 7.000 EU 15 28 ITALY
P1-89-2007 |©8.53 I1JHS S5B A48m 7.0008 EU 15 28 |ITALY
P1-09-2007 ©8.52 I72GNQ SSB A48m 7.000 EU 15 28 |ITALY
P1-09-2007 08.51 TWOHIE/P 55B 48m 7.000 EU 15 28 TTALY
P1-89-2807 03.58 TK2SAKW S5B 48m 7.808 EU 15 28 |ITALY
91-89-28607 083.50 TK1IXVO S5B 40m 7.000 EU 15 28 |ITALY
91-09-2007 08.58 IK15UB S5B 40m 7.800 EU 15 28 |ITALY
01-09-2007 ©8.49 HBYEF] S55B 40m 7.800 EU 14 28 |SWITZERLAND
01-89-2007 |08.49 EASAT 55B ABm 7.8008 EU 14 37 |SPAIN
01-09-2087 ©8.48 S58MU 556 A48m 7.800 EU 15 28 |SLOVENIA
01-99-2007 08.48 OM3YCA SS5B  40m  7.088 B 15 28 SLOVAK REPUBLIC
P1-09-2007 ©8.47 IK2WZQ/5 55B 48m 7.00600 EU 15 28 TTALY
P1-89-2007 |03.46 I8RA] S55B ABm 7.000 EU 15 28 |ITALY
P1-89-2007 |08.45 S53ED SSB A0m 7.000 EU i 28 |SLOVENIA

The ' Packet Cluster \vindow is in the upper left area:

File Log Strumenti Stampe Award Manager 2?2

I < g CLUSTER

Conn. [GBFUIS] X Disconn. @ Pulisci {; Richieste al Cluster ~ | A Invio SpotDx | ANTARCTICA : New DXCC in 30m

7196.0 EA2KC

28006.0 ZL2IFB
1820.0 W1KM 80W here
7008.3 DX1] QsX UP...CQ EU
7879.0 IKeChQ

14681.6 O0QAACN RTTY Calling CQ
18150.8 YV5HNI] thanks for contact
i8141.8 DP1POL up 1

| CLUSTER MONITOR |FILTERED 50TS | Mon RQ. | wwv | Messack | TaLk | ann | s [

g



And the SPOT WINDOW that shows all info in the upper right area: when a spot arrives in the yellow
stip will be shown your situation for that Country in the spotted band.

The colours have the following meaning:
WHITE = not worked,

- = worked not confirmed,

GREEN = confirmed,

YELLOW = confirmed via LoTW

CYAN = credited by the DXCC Desk:

KODK

uTcC : 14.58.04

Freq.: 21.203 Mhz
[ [
DXCC : UMITED STATES OF AMERICA

QRE = 9673 km - Short : 319° Long : 139°

Sitvation on : 15m

- KR E3ER
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The Log Sheet

"3 BETERM /%3 LOGGER |
" Nuovo Qso (F2) | | Ricerche (F3) |5 Qsls - ) QsIR - | /5 RAC | §# Manager | [f] Colonne log - (g Ricerca REF.
IDD MM-YYYY UTC Time CALLSIGN Mode Band FREQ(Mhz) WAC WAZ ITU DXCC
91 09-2007 108.55  I72KXC/1/P |SSB__40m 7.000  |EU 15 128 ITALY

IIlJHS 'SSB 40m 15 [28 ITALY

| I72GNQ 'SSB 46m | 7.000 [Eu 15 [28 [ITALY

_@1 09-2007 08.53
01-09-2007 |08.52

[01-09-2007  08.51 (IWOHIE/P 558 4om |7.000 [Eu [15 [28 [TTALY

|01-09-2007 |08.50 | IK2SAW 'SSB | 46m |7.000 EU (15 [28 |ITALY
01-09-2007 ©08.50 | IKIXVO 'SSB 40m |7.000  |EU 15 |28 |ITALY
01-09-2007 | 08.50 ' IK1SUB 'SSB 4em |7.000 [EU (15 [28 [ITALY

[01-09-2007 |@8.49 'HB9EFJ SSB | 40m  7.000 EU |14 [28 |SWITZERLAND

l01-09-2007 |08.49 |Eﬂ5ﬂT 'SSB 40m I?.eae EU 14 |37 SPAIN
01-09-2007 108.48 | S58MU 'SSB 40m EU |15 |28 |SLOVENIA

o1 99_2%2__'_téjs'?ii';_'fi@@@a_/_ﬁ_' SSB 4om |7.000  |EU 15 [28 |ITALY
|01-09-2007 |08.46 | I8RAJ 'SSB | 46m |7.000 EU |15 |28 |ITALY
91-09-2007 |@8.45 |S53E0 'SSB 40m |7.000 'EU |15 |28 |SLOVENIA

The Log sheet appears like in the picture, with a toolbar upon it.
The key LOG COLUMNS allows to choose between auto-sized columns and manually-sized
columns, furthermore it gives the capability to show the columns at discretion and to position them in
any order.
All columns are alphabetically sortable ( A-Z ) or vice-versa ( Z-A).
The column DD-MM-YYYY can sort the QSOs from the most recent to the oldest one or vice-versa.
Not all existing columns are shown: the colums related to the Awards are advisably shown ( see
section: Awards ).
To quickly move in the field DXCC once it has been alphabetically sorted, it is possible to use the
combination Ctrl+letter. As examble Ctrl+N leads the selection to the first QSO of first Country
starting with letter N, like the Namibia.
Other keys of the toolbar are: NEW QSO - F2: it opens the input QSO data window; SEEK - F3: it
opens the Lookup window, QSLs and QSLr: manage the QSL cards sent and received; RAC: runs
the RAC, Radio Amateur Callbook if the CD ROM is in the drive, or if its content has been copied on
the HD; MANAGER: opens the manager seek window.
The QSL cards can be managed also through the SEEK - F3 window: with a left button click you can
select a QSO: the background becomes Eﬁg
After that, a right click shows a box with these options:
QSL card received via the Bureau (YY)
QSL card received per Direct (D)
QSL card rejected (QSLr=R)
That changes the background colour of the row from WHITE indicating QSOs not yet confirmed and
with QSL card still to send ( QSLs and QSLr = N)) to:
for QSOs confirmed ( QSLr =Y or D for via direct )
YELLOW for QSOs that the QSL card has been sent (QSLs =Y orD)
for QSOs for that the QSL card is not to send ( QSLs = X ) and not yet confirmed ( QSLr = N)
for QSOs confirmed but with our QSL card is still to be sent ( QSLs=N and QSLr=Y orD)

14



GREY for QSOs that our QSL card has been rejected: not in log, not member, unclaimed, silent key,
etc. (QSLr=R)

Each QSO is editable through left click + right click then selection EDIT QSO - F4 or deletable with
left click + right click then option DELETE QSO

The eQSLs and LoTW management is separate from paper QSL management.

A multiple selection of the QSOs is possible keeping pressed the SHIFT KEY and selecting the
QSOs with the left button of the mouse or with the Arrow Down Key.

To made a selection with the mouse press the SHIFT KEY and select the first record and the last
record with the left button of the mouse.

If you wish to made a not consecutive selection the key to keep pressed is CTRL.

Once the selection has been made, a right click opens a menu with 5 options:

EDIT BAND: allows to change the band at same time for many QSOs

EDIT DATE: allows to change the date at same time for many QSOs

EDIT MODE: allows to change the mode at same time for many QSOs

EDIT COMMENTS: allows to insert/edit the content of the field COMMENT of all selected QSOs at
same time.

GET DATA FROM CALLBOOK: this option is very useful if you have many QSO without Name and
QTH.

Through this utility you can complete the data getting them from the selected callbook.

DELETE SELECTED QSOs: deletes selected QSOs from the log.

15



Insert QSO

/] Dati Q50 ==

-

/¥, Forza DXCC = = STATUS DXCC (F8) |[Z] STATUS CALL (F8) | ; LookUp Qrz.com  {§) LookUp GRID SpotDx

Call Info |10TA | Custom Award |

[
2ot 27/03/2010 [~ l—J I S UNITED STATES OF AMERICA
T On 17.03 = T _Off 17.04 =2 WAC m WP m E

| cALL  wsern Usr LoTwd WAZ mu El |
Banda 20m - Freq. 14.000 Mhz AZIMUTH - Short : 304° Long : 124°
Modo  ssB ~ ORB 6954 Km il BE2R1E 12834
i v | Qsiueaupiect [eos. (Lo [Qstxsw|  QslManager
RSTr 59 - o | QSLMng Local (F10) |
GRID ENB2DM asts (M =] osir (M~
L | Q5L Mng OnLine (F11} ]
PROP SAT Name SAT Mode PWR | 1000 |2
fnfo COUNTY { MI-LIVINGSTON ) - WAS { [MI] MICHIGAN )

Nome Evangelo Diamantoni

QTH 5056 Kierstan Dr Brighton |, 48114 [USA ] E Salva Qso (Ctrl+s)

Note

L% 4

This is the window to insert the QSO. With A the software gets date and time from the computer
clock, with [l it is possible to insert QSOs later, selecting date and time. If you have an active
callbook installed the software gets the info related to that callsign from it, inserting also the data for
the awards related to that callsign. As example,inserting an U.S. callsign like in the picture, the
softare is able to find the State and the County, that are automatically inserted in the proper award
area. Prop allows to choose the propagation, e.g. AU (aurora) MS (meteor scatter), etc. Choosing
SAT (satellite) i twill be possible to select the Satellite (SAT Name) and the employed SAT Mode.
The PWR box is to insert your transceiver power. A double-click on the Info yellow strip produces a
refresh of the window.

For each inserted callsign you can check the Country Status with F8 and if you had previous QSO
with that station with F9. With Lookup QRZ.com you can access that OM’s page by QRZ.com (if
existing) and with Lookup Locator you can open a browser window on a map showing that WWL
square. You can also get data from QRZ.com with ALT+Enter. The central part of the window allows
to determinate your behavior in order to QSL card / eQSL card / LoTW . Also it is possible to import
the Callsign from the Spot Window or ftom the Filtered Spot Grid by a double-click on the Call. Re-
opening a recorded QSO with F4 you can also use the QSL to SWL section to insert the SWL call
and put this report into the QSL printing buffer. QSL Mng Local (F10) and QSL Mng OnLine (F11)
allow to get data about the QSL Manager from the local database by IK2XDE or via Internet from
IK3QAR’s on-line database. With Force DXCC you can force a Country in place of that proposed by
the software (e.g. for ambiguous prefixes).

The Sections IOTA and Custom Awards allow to insert informations for IOTA and several awards
related to that callsign.:
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- POLSHA

| callInfo | 10TA | Custom Award

[R] MAZOWIECKIE

S5P_POWIAT-

[WM] WARSZAWA :

- LIGHTHOUSES

(2] (&)

“WFF-

feaE i = 5
il : 1 I 1 I' ,_E o I-

| /4 Forza DXCC | & Status DXCC Storice CALL | = - LockUp Qrz.com | g LookUp Locator
: g

In this example you can see the situation about a SP callsign: the Awards you can manage are the
POLSKA Award, the SPPA, the Lighthouse Award and the World Flora Fauna Award.

The data about POLSKA and SPPA have been taken automatically from the informations contained
into the callbook and elaborated through the internal database.

Delete QSO

To delete a QSO from the log sheet just select the row (left button click) and then a right button click
shows a menu from whic you can select DELETE QSO. A confirming box will open, and you must
confirm the deletion clicking on YES. In Expeditioner mode just hit CTRL+CANC. Be very careful
because this function works only with insert QSO windows open, and deletes last inserted QSO
without opening the confirming box.

= | =~

20 MA
T0m NA Sn |
20m EU 15 Hat | Eliminare questo QSO? N
15m EU 15 K2 M
15m MA 1 KL7 [ Si ] [ Mo ] M
15m EL 14 MO M
15m EU 15 ua1 19 EUROPEAN RUSSTA N
40m EU 15 L) Pl ITALY M
40m EU 15 I3 M
40m EU 4 o7 ]
40 EL bli] TAL 19 TURKEY M
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Edit QSO

Select a QSO with a left button click on a row. The background colour becomes blue.Now click on the
row with the right button of the mouse. A menu will open: EDIT QSO (F4) and DELETE QSO.
The function EDIT QSO opens a window exactly similar to that to insert a QSO:

-

=
4] Dati QSO [=]E]

/¥, Forza DXCC = & STATUS DXCC (F8) | [=] STATUS CALL (F9) | ; LookUp Qrz.com ) LookUp GRID SpotDx
CallInfo | 10TA | Custom Award |
-
Data 27/03/2007 [3 Country TR
T_On 17.17 = T_Off 17.18 = WAC E WP |
| cALL Py WAZ U - @ |
Banda 40m -~ Freq. 7.000 Mhz
Modo  ssB -~ ORB 9243 Km
RSTs 59 * | QsLBureau/Direct |eQsL | Lotw [ Qs xSwl| Qsl Manager
RST 59
é f |  QSLMng Local (F10) |
o T Qsts [0 »| qsir [0~
| QSLMng OnLine (F11) |
PROP SAT Name SAT Mode PWR | 1000 |=
Info WABRA [ STATE OF RIO DE JANEIRO )
Nome Roberto Domingos Dos Santos |
QTH Rua Tangara Nr 445 Bonsucesso Rio De Janeiro 21050520 R [ Brazil ] ‘H Salva Qso (Ctrl+s)
Note
L ”

From this window it is possible to edit the QSO, like to put Y or D in the field QSLr when a QSL card
comes (D = QSL card received via direct). Also you can record your eQSL and LoTW confirms. There
Is a quick way to set the status of the QSL, and it is on the toolbar upon the log sheet: QSLr

b2 LOGGER
" Nuovo Qso (F2) | |3 Ricerche (F3) &) qsls ~ FQsiR ~ | (& RAC | £# Manager | [i-] Colonne Log ~ | (g Ricerca REF.

Use SEEK (F3) to find the QSO and with a left button click select it, then a right click will open a
menu. From this menu you can select the opportune condition (received via direct, received via
bureau, rejected).

Regarding the window INSERT QSO, this one offers a particularity: to search the callbook (RAC,
Worldcall, Radamato and/or QRZ.com, (see INITIAL SETUP) the combination CTRL+Enter has to
be used, not just ENTER or TAB. To search on www.qgrz.com the combination is always ALT+Enter.
In this phase you can also manage the QSL cards for SWLs. With QSL to SWL a box will open. Here
you can enter the SWL callsign and even a Comment. In this way this HRD will be put in the
printing buffer for the labels or QSL cards to SWLs.

N.B. These functions are not available for the logs “Expeditioner”. To get that possible you need to
re-record a log “Expeditioner” into a “Hunter” one, our station log or some other log created for
that. To put the log into another log the ways can be IMPORT ADIF or MERGE LOG.
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Searchings

Through the SEEK (F3) key it is possible to perform various searchings in the Log, using many
searching keys.

AttivazioniDAI
WAC IG IK2UVR

19D K WAZ '
CANADAWARD mu
CASHOTA WPX

CCA OPERATOR
cce QTH

CDM [7] QsLs

CISA [¥] QSLr

E.g. you can seek all the contacts had with a call, or by QTH, by date, etc. Entering K3, selecting
CALLSIGN as search key, you get a list of QSOs with stations with call starting with IK3. Entering
instead a full call (IK3ABY), you get a list with all QSOs had only with that call, in all the variations.
So not only IK3ABY but also F/IK3ABY, IK3ABY/IL3, IK3ABY/P and so on. Selecting the logs you can
perform multiple log searches.

=} Ricerche p=f O] X
Campi Awards Campi del Log Campo Ricerca Logs > AttivazioniDAL
CEEN - | ([ wac | |cawsien - IK2UVR
19D || | waz
CANADAWARD huil] ik3aby
CASHOTA WPX
CCcA OPERATOR
ccc QTH
CDM [¥] QsLs
R =i Gor T G2
LoghName DD-MM-Y¥YYY  UTC TIME CALLSIGN DXCC MODE BAND Q5ls -
IK2UVR 03-09-2005 08,16 IN3/IKIABY /P ITALY 558 40m ¥
IK2UVR 20-11-2004 10,39 IK3ABY ITALY S5B 40m e =
TK2UVR 20-11-2004 0211 IK3ABY TTALY S5E 40m ¥
TK2UVR 09-10-2004 09,49 IK3IABY /P TTALY 558 40m ¥ =
| IK2UVR 29-05-2004 07.22 IK3ABY ITALY 558 40m ¥
|| rkauvR. 19-07-2003 07.02 IK3IABY ITALY 558 40m ¥
| TK2UVR 27-10-2001 06.42 IK3IABY /R ITALY 558 40m ¥ i
B K - 3

Using as search key the date you can use the boolean operators >= (major or equal) and <=
(lesser or equal): e.g with limits 01/01/1995 and 31/01/1995 you can extrapolate all your QSOs
made in January 1995:
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Campi Awards Campi del Log Campo Ricerca Logs = [F] AttivazioniDAL
| Dr— [T | e 7 120w

] c19D | 7] waz

|| CANADAWARD ] T

] CASHOTA | WPX

[eca [ OPERATOR Data >= 01/01/1995 ~

[F] ccc | QTH

[7] coM Qsls Data <= 3j/p1/1995 ~

El csa ~ | @] Qstr "] cotertrovati £ 1

Loghame DD-MM-YYYY  UTC TIME CALLSIGN DXCC MODE BAND QSLs
24-01-1995 13.30 < SCOTLAND
18-01-1995 13.20 ONTKK BELGIUM RTTY 20m ¥
18-01-1995 13.10 RW3GU EUROPEAN RUS... |RTTY 20m ¥
11-01-1995 13.24 LZIR BULGARIA 5SB 20m ¥
11-01-1995 13.13 YOGGBF ROMANIA 5B 20m ¥
03-01-1995 22,00 S57NRO SLOVENIA 5B 80m ¥
02-01-1995 | 13.00 RABT |EUROPEAN RUS. .. |RTTY 20m ¥

L1 |
— - —— — -— ——

The listed QSOs are editable with the procedure: left button click (of the mouse) - right button
click - edit (or F4) exactly like in the Log sheet. See EDIT QSO. Clicking on the EXCEL icon on the
right you can export the result of your search as an Excel document.
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Packet Cluster Terminal

File Log Strumenti Stampe Award Manager 2?2

g CLUSTER

Conn. [GBFUIS] X Disconn. @ Pulisci g} Richieste al Cluster - | A Invio SpotDx | ANTARCTICA : New DXCC in 30m

7190.@ EAZKC 22487
28006.0 ZL2IFB 22487 EL86
1820.0 W1KM 80W here 22487 IN96
7808.3 DX1J Q5X UP...CQ EU 22487 EN82
7879.8 IKeCWQ 22497

14681.6 O0OAACN RTTY Calling CQ 22497
18158.8 YV5HN] thanks for contact 22477
18141.@ DP1POL up 1 22497 KNe4

| CLUSTER MONITOR  FILTERED SPOTS | MON RQ. | wwv | MESSAGE | TALK | Ann ESEmP'_

his is the Packet Cluster Terminal. It is composed by two windows: the traffic window and the
command interface window below it to dialog with the remote system. The program gets
automatically the owner's Callsign and with it connects the remote system. The font and its size are
selectable by a right click on the windows. A selection window will open and the user can perform his

settings:

|| Tipo di carstters: Stile:

Courer New Grassetto

Marmale

S| |
Lok |

Daniela

il | €} DaunPenh
{} David x
Effetti Esempio
[7] Bamato
[] Sottolineato B.a.BbYYEZ |
|
Scrttura:

Cecidertale -
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First of all some SETTINGS are requested:

File Log Strumenti Stampe Award Manager ?

U3 CLUSTER

¢ Conn. [GBTUIS] ¥ Disconn. ﬁ Pulisci é Richieste al Cluster ~ | A Invio SpotDx _j NICARAGUA : Mew DXCC in 40m

GENERAL | TELNET | RADIO | FILTERS | ALERTS|

|  RxFontColor |

1 Radio Cluster

@ Telnet Cluster
: Rx Background Color
7y Cwskimmer [ ]

]!CLUSIER MONITOR | FILTERED SPOTS | MON RQ. | WWV | MESSAGE | TALK | ANN | sETup ;

In the section GENERAL we should choose the media we can use in our shack: Radio Cluster for
VHF or UHF connections via TNC or Telnet Cluster for Internet connections. Third option, Cw
Skimmer, allows to transform the Packet Cluster window in a Cw Skimmer Terminal, if we have this
software installed in our computer (http://www.dxatlas.com/CwSkimmer/) . Rx Font Colour allows to
set the foreground colour and Rx Background Colour that of the background
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2 CLUSTER

Conn. [GB7UIS] ¥ Disconn. a Pulisci |§ Richieste al Cluster v| A Invio SpotDx _J METHERLANDS ANTILLES : New DXCC in 40m

| GENERAL | TELNET | RADIO | FILTERS | ALERTS|

N S et ]

Telnet
Nodes Telnet |GB7UIS ~| [ Modifica Nodo ]
>Internet Telnet Link< [ Aggiungi Nodo ]
[ Cancella Nodo ]

]I CLUSTER MONITOR | FILTERED SPOTS | MON RQ. | WWV | MESSAGE | TALK | ANN | SETUP R

The TELNET option allows to select the node for the connection. The software gets for default ther
USER'S Callsign or that one specified in the field NODE LOGIN when a new node is added (ADD
NODE) or when an existing node is edited (EDIT NODE), and with it connects the selected PCL. it is
possible to insert a PASSWORD foe each Telnet Node. The nodes can be deletedwith DELETE
NODE. The Internet Telnet Link drives to a web page that contains a big list of Telnet nodes with all
data for the settings. Here are the node settings:
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FormModeCluster @

Node Name GB7UIS
Node Address  83.104.58.62
Node Port 7373

Node Login IK2UVR

MNode Password

Node Type DXSPIDER - | ok |

It is possible to insert all the data related to that Node and to select the Node Type between
DXSPIDER, DXNET and ARCLUSTER.

File Log Strumenti Stampe Award Manager 2

4z CLUSTER

Conn. [GBTUIS] ¥ Disconn. ﬁ Pulisci | g} Richieste al Cluster - | A Invio SpotDx _J UNITED STATES OF AMERICA : New DXCC in 80m

| GENERAL | TELNET| RADIO | FILTERS | ALERTS
THC Radio

ﬁ TNC Commands >3 MM ON l Modifica Nodo ]

[ Aggiungi Nedo |
S —
o [ Cancella Nodo |
e e Nodes Radi

e5 {(+]

TNCType |UNKNOWN - e i
" ]

ﬂ CLUSTER MONITOR | FILTERED SPOTS | MON RQ. | WWV | MESSAGE | TALK | ANN _'i SETUP :

With RADIO we can set the paameters in case of connection via Radio to a Packet Cluster: ComPort
is the serial port used, Speed in bauds indicates the data transfer speed between radio and computer
(mostly 9600 but some exceptions can occour), TNC Type allows to select the built-in parameters for
several TNC, and Handshake allow to set the protocol, if needed (None, XON/XOFF, RTS or
XON/XOFF/RTS). Usually with some trials the user can easily set his TNC. Also with the option
Radio there are the keys for EDIT, ADD and DELETE the Nodes. Nodes Radio is a menu that
shows and allows to select the Node we are going to connect and Set TNC Radio is a key to select
the mode Radio Cluster, like in secion GENERAL. The central window TNC Commands shows the
setting commands sent to the TNC function of the choice done with TNC Type.
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File Log Strumenti Stampe Award Manager 7?2

/U5 CLUSTER

¢ Conn. [GBFUIS] ¥ Disconn. @ Pulisci 1} Richieste al Cluster ~ | A Invio SpotDx '__| BAHAMAS : New DXCC in 40m
| GENERAL | TELNET | RADIO | FILTERS | ALERTS |
Filter Band Filter Mode Only Dx Selected Callsigns Selected Comments
oo =) [Eeone | 20 (I |
[7] 80 Mt | | | rTY ot |—
Vaomt |- [7] cw [C] AF |l _:|
W/30mMt | [¥] DIGI ] AN IE BE
@22omMt — []as | |
] 17 Mt [¥] EU '§=__
[¥] 15 Mt [ A E ok |
] 12 Mt [[oc ! Rl
FlioMt - [[] sA = -

u_{ﬁsrm MONITOR | FILTERED SPOTS | MON RQ. | WwV | MESSAGE | TALK [ Ann | sprup ;

he option FILTERS allows to set some filters on the spots according with that we want to put in
evidence: Filter Band allows to select the interesting bands and Filter Mode the modes. Only DX
spotted from allows to select the continents from which the spots comes, excluding as example
those whom spots cannot be useful for us. These selections will be valid only for the spot window
and for the filtered spot window. In the main window all the spots anyway will be shown. With
Selected Callsigns the user can insert the Callsigns to monitor: when these Callsigns will be spotted
a special alert in [MIMGENTA colour will start to flash in the upper toolbar and a ﬁ strip flashes in
the SPOT Window (double-click to cancel). The same in Selected Comments: if we are monitoring
a certain IOTA expedition, we can insert the reference, and when this reference will appear in the
notes of any spot the flashing alert will appear (of course the exact syntax must me respected: if we
set AN-001 and the spot contains ANOOL1 it won't be recognized)
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g CLUSTER

Conn. [GB7UIS] ¥ Disconn. ﬁ Pulisci |§ Richieste al Cluster v| A Invio SpotDx _] BAHAMAS : New DXCC in B0m

BB R T |
I
L

| GENERAL | TELNET | RADIO | FILTERS | ALERTS

[] Icon Spot [7] Spot Marker [ Spot Marker Color I
[7] Speech Spot [#] Check Calls

[7] Sound Spot [¥] Check Remarks

[¥] NewOne Filter [¥] Spot > QS0

The section ALERTS allows to select all concerning those spots we are interested to: Icon Spot
shows a balloon with all the dataof the spots beside the tray (lower right corner of the screen). it is
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useful if we have the program minimized because the balloon has the priority over any other window
and appears always in foreground. Speech Spot gets the computer talking with a spot comes: a
female voice will play the Callsign with the ICAO phonetic alphabet (alfa, bravo, charlie delta,
echo...). More voices are available at www.bblogger.it with 5 languages prononciations. If we don't
want a voice but a sound we can select Sound Spot instead of Speech Spot. Spot Marker allows to
change the foreground colour of the selected spots, those who are under the conditions set in
SETUP>FILTERS, and the key Spot Marker Colour allows to select the colour. The box Spot>QSO,
if tagged, allows to transport the spot to the Insert Qso Window (F2) with a double-click on the
callsign appeared in the Spot Window or in the Filtered Spot Grid. Check Calls and Check
Remarks if tagged that allows to get the alerts flashing when the selected Callsigns or the
Comments selected in SETUP>FILTERS will appear.
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. Conn. [GBTUJIS] ¥ Disconn. @ Pulisci é Richieste al Cluster ~ | A Invio SpotDx _j BAHAMAS : New DXCC in 40m
FREQ. (Mhz) CALLdx NOTE uTc Spotter COUNTRY User LoTw
3.515 UAOBA TMX ANDREY 73 23.48.22 EATON ASIATIC RUSSIA ' es &
7.013 1B1AB Op:Soyer 23.52.48 IKGSIO PREFIX NOT ALLOCATED / ...
7.038 CT1IBWU 23.53.21 CT1CDP PORTUGAL
7.025 CBAPG tnx Q50 23.54.36 RU3LA BAHAMAS
3.584 CeARU OLIV1A 50016 CQ'ing 23.57.15 OZ1PMX BAHAMAS
71.197 E@ N 23.58.51 ElGIK IRELAND
7.025 CBAPG ca... 00.05.31 RABGEE BAHAMAS
3.700 HFBBOTAR | IN660B<> 00.10.43 IW3RQOL POLAND
10.110 SN50K no takers 00.11.04 SQsvVD NIGERIA
UTSURW BAHAMAS

| Esrem oo reseo spors o wa wwy  essace i [ seor

Selecting FILTERED SPOTS this grid appears: in it there are all the spots that satisfy our conditions.
The cell background colours allow to know our situation about that Country o that Prefix (for WPX).
Same colour code appears beside the orange symbol of the feed in the upper toolbar: this is the
meaning: YELLOW means a NEW ONE DXCC in the specified band, means a NEW ONE
DXCC IN ANY BAND, GREEN means a NEW PREFIX in the specified band and CYAN means a
NEW PREFIX IN ANY BAND. A DOUBLE CLICK on the grid transports all the data related to that
spot (callsign, band, mode and note) in the Insert QSO window if the box Spot>QSO in
SETUP>ALERTS is tagged. Selecting a row and hitting F7 we will have the DXCC situation of that
Country (see last picture). Last column tells if that Callsign is member of the LoTW program (in our
example UAOBA).
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File Log Strumenti Stampe Award Manager 7
W3 CLUSTER
Conn. [GEFUIS]

7802.0
10114.8
l14002.0
18083.8
21302.0
28025.6
1e1e5.3
18145.0
2107e.7
14267.1

% Disconn. | fif Pulisci | ¥ Richieste al Cluster ~ | A Invio SpotDx ||| VB3 : New WPX in 15m

V31RI
RZGAF
CO8LY
RN3GL
VK6IR
VK9X/G6AY
F@/N6J1A
VK6hC
LU3HR
AP2DKH

22-Feb-2010
22-Feb-2010
22-Feb-2010
22-Feb-2010
22-Feb-2010
22-Feb-2010
22-Feb-2010
22-Feb-2010
22-Feb-2010
22-Feb-2010

| CLUSTER MONITOR | FILTERED SPOTS | MoN RQ. WWV | MESSAGE | TALK | Ann

gud sig
Nice sig in
tnx

.

529 did not
579 73 cqcq

Eastern WV

hear me

BPSK31 Fernando
tu khalid by LP ;-))

output is directed also to the main window Cluster Monitor.

<JATMBT>
<K80QL>
<UA3UCD>
<IK3GER>
<IZ5I0S>
<PA7MM>
<KEAWBO>
<EISIF>
<DOAZH>
<YV5IF>

| servr I

The MON RQ window is the output of our requests to the Packet Cluster made with the key in the
upper toolbar. In this way the info won't abide the scroll due to the coming of new spots. Anyway the

File Llog
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Stampe  Award Manager ?

83 CLUSTER

.;f{ﬂnn.[GB?UJS]

 GrEmE |

PROPAGATION
Wwv/10
WWV/100
WCY/10
WCY/100

SATELLITE
AD-03 *:

X Disconn. @ Pulisci é Richieste al Cluster -~ | A Invio SpotDx | BAHRAIN : New DXCC in 40m

Date

24-Feb-2010
24-Feb-2010
24-Feb-2010
24-Feb-2010

24-Feb-2010
24-Feb-2010
24-Feb-2010
24-Feb-2010
24-Feb-2010

| Spot WWV | WEB Info|

| CLUSTER MONITOR | FILTERED SPOTS | MON RQ. | wwv

L= = T = = T T« T T = T =

M KM WWWKMNRKNNSR

| MESSAGE | TALK | ANN

m
]
o

R RIS RERREXR

Aurora
no
no
no
no
no
no
no
no
no

Logger
<DKOWCY>
<DKOWCY>
<DK@WCY>
<DKOWCY>
<DK@WCY>
<DKOWCY>
<DKOWCY>
<DKOWCY>
<DK@WCY>

S

WWYV gets this window appearing (above) that provides info about the sun activity, last 10 or last 100
spots can be shown with display WWV or WCY.
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File Log Strumenti Stampe Award Manager 7

/g CLUSTER

L'¢ Conn. [GB7UIS] ¥ Disconn. @ Pulisci | % Richieste al Cluster - | A Invio SpotDx || | ¥V2:HNew One WPX I

GREVUIIE | Spot WWV | WEB Info|
it allo ol From Callsign: IK2UVR Lat: 45 36 N Long: 8 47 E
wwv/10 Tracking Table for A0-49 for the next 3 hours every 5 mins
WWV/100 dd/mm UTC Lat Lon Alt Km Az El Dist Km
werian Now 19:47 -28.8 64.5 660.4 133.4 -42.1 9463.5
il >5 /02 20:57 . 605.8 318.1 2.0 2628.9
Sl ol 25/02 21:02 600.7 278.8 40.5 876.1
m Bl 25/02 21:07 30. 601.4 166.1 10.8 1882.8

25/82 22:37 602.9 -4.1 3337.1

l[cws ER MONITOR | FILTERED spoTs | Mon RQ. wwy | MEssace | TaLk | ann | seue [

SATELLITE allows to get the keplerian data of the amateur and meteo satellites just selecting the
satellite from the proper menu.
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/2 CLUSTER

i.¢ Conn. [GB7UIS] X Disconn. a Pulisci | % Richieste al Cluster -~ | A Invio SpotDx || | ANGOLA : New DXCC in 15m

GREYLINE | Spot mw, 'WEB Info

PROPAGATION |

gepectrial Data - 20818 Feb 25 1811 UTC

WWV/10
WWV/100
woyY/10
WCY/100

SATELLITE
AD-49 X
S MHoize 58-51
Geonag VE BDUIET
http:/ uuu_nBnb

.con {C} Paul L Herrnan 2818

[ cLusTER MontToR | FiLTERED spots | Mot Re. | wwy | Messace [ Tak [ ann_| serue [

GREYLINE shows the above screen with the greyline and other info.
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W2 CLUSTER

;"1;‘ Conn. [GB7UIS] X Disconn. a Pulisci Q Richieste al Cluster ~ A Invio SpotDx | V&3 : New One WPX W

GREYLINE | Spot wm:;'-WEB Info

PROPAGATION
___ Solar-Terrestrial Data -
wwv/10 8 Feb 25 1811 UTC YHF Conditions HF Conditions
Sol a Tten Status Band Day Hight
WWV/100 dex Aurora 80n-48n  Fair Good
: 1 1] Aur Lat 30m-20n Fair Fair
] 2n EsEU 17n=-15n
ik 12n=-18n
1| Geomag Field YE OQUIET
WCy/100 Sig Hoise Lvl 58-51
SATELLITE
AD-49 =

n'éLﬁéﬁﬁ'ﬁh'm"'mﬁ’iﬁ[ﬁﬁth’éﬁﬁis“{'iv'itiii'ﬁd'.'i wwy | Messace | TaLk | ann | serve D

PROPAGATION shows the above screen with the data related to the conditions of the sun and the
propagation in the various bands.
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s CLUSTER
Conn. [GB7UIS] ¥ Disconn. @ Pulisci g} Richieste al Cluster -~ | A Invio SpotDx || NETHERLANDS ANTILLES : New DXCC in 80m
DIR | DIRLIST | MESSAGE | SEND MESSAGE|
DIR/100 | Msg Size To From Date Time Subject
DIR/BULL | 1301 16543 ALL WSAL 6-Feh 21517 DX Mews Letter #1661
1302 70 ALL SPSLIAF 8-Feh 22217 Z2IDXI
DIR/NEW :
1303 4603 ALL KMN4F 11Feb 21302 ARLDOOG DX MEWS
DIR/OWHN 1304 4231  DXME... EASNQ 12-Feb 1010Z  Boletin DX06 (ARRL, 11-Feh)
- | 1305 9378  KEPS  IRSPWI6  13Feb 0000Z  Zline Orbital Elements 10042.4
PrintView Msg 1306 10022 ALL 12PQW 13Feh 11247  425D%M CALENDAR #9380
1307 7974 ALL WAL 13-Feb 20072 ARLPOOS Propagation Bulletin
1315 17633 ALL WAL 16-Feb 19437 DX Mewsletter #1662
1334 126 ALL PPSMCE 18-Feb 03162  Flag Counter Test
1340 4074 ALL KM4F 19-Feb 00192 ARLDOO7 DX NEWS
4 nr

“ELUSTER_MOH_I?ERE FILTERED SPOTS | MON RQ. | WWV | MEssaGe | TALK | Ann jsm_r;"_

MESSAGE introduces the section dedicated to the messaging of the Packet Cluster. In the above
screen we can see the list of the messages transited on the PCL we can get hitting the DIR key.
DIR/100 shows last 100 messages, DIR/BULL shows the list of the bulletins, DIR/NEW shows the list
of the NEWS messages and DIR/OWN shows the list of the messages directed to us. Each message
can be selected with the left key of the mouse flashlighting the row and with the right key of the
mouse can be read selecting READ MESSAGE. The window MESSAGE will open and the text of the
selected message will appear. With PrintView Msg we can get a preview of the selected message in
order to print it. The messages directed to us can be also deleted witr the command Delete Message
apearing with the right key of the mouse Other messages cannot be deleted.
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File Log Strumenti Stampe Award Manager 7

2 CLUSTER

_¢ Conn. [GB7UIS] | ¥ Disconn. ﬁ Pulisci | i Richieste al Cluster - | A Invio SpotDx I:J PUERTO RICO : Mew DXCC in 40m

DIR | DIR LIST | MESSAGE | SEND MESSAGE |

DIR/100

To [ From IK2UVR
DIR/BULL

DIR/NEW Subject Private

DIR/OWN l P ]

PrintView Msg

ECLUSTER monrmor | FLTeReD spots | Mon RQ. | wwv | messace TaLk | ann | serue [

SEND MESSAGE allows to send a message to an uer (inserting the call in the box To) in a private
way (tag in Private) or to ALL in a public way.

File Log Strumenti Stampe Award Manager 2?2

W3 CLUSTER |
% Conn. [GB7UIS] % Disconn. | { Pulisci | ¥ Richieste al Cluster ~ | A Invio SpotDx |:J—
Chat | caLL Info

Call To Send=> Node PCL >

< message+enter

CLUSTER MONITOR | FILTERED SPOTS | MON RQ. I Wwv | MESSAGE | TALK

ANN | SETUP

With TALK we can send and receive short messages, like in a chat. In Call to send we have to write
the Call of the User we want to send the talk, and possibly the Packet Cluster Node if that User is not
connected to the local Node. In the box below we can write the short message and with Enter we can
send it. The larger pale blue backgrounded window will show the traffic of the received talks.
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3 CLUSTER

Conn. [GBTUJS] ¥ pisconn. | g Pulisci |i§ Richieste al Cluster v‘ A Invio SpotDx || | SENEGAL : New DXCC in 80m

CALL Info
Call To Seek » IK2ZWZQ

Last connect : 18-Feb-2010 23177
QTH : busto a.

Location 4536 N 852 E (IN45KOD)
Heading : 90 Deg. 4 Mi. 6 Km.
Home Node : HBOOK-9

CALL INFO allows to get info about a Call connected to the Cluster Web. This tool is useful to know
the Home Node of that User to address the Talks.

File Log Strumenti Stampe Award Manager ?

3 CLUSTER

‘¢ Conn.[GB7UJS] | ¥ Disconn. | fg Pulisci | ¥ Richieste al Cluster ~ | A Invio SpotDx [

ANN/10 | List Announces | New Announce

ANN/100 18-£eb-2010 23.00z -» * GBTUJS CLUSTER: EB7UJS telnet gbTujs.shacknet.mu Port 7373 ID at Z300Z on 18-Feb-2010
18-feb-2010 23_00z -> ALL GB7UJS CLUSTER: GB7UJS telnet gb7ujs.shacknet_nu Port 7373 ID at 2300Z on 18-Feb-2010
ANN/500 18-£eb-2010 23.37z -> ALL CT1HMN pse ICTAR CEREQ
13-feb-2010 23_38z -> ALL SVIENK CT1HMN. ____ NA-113
ANN/1000 18-feb-2010 23.52z -> ALL YVSANF veTec last update 2.3804, womderfull, svery dsy better znd better, tks

15-£feb-2010 00.00=z -»> ALL UR4FBE Cluster: new addr. telnet uad4fbg_ru:8000
19-£eb-2010 00.01lz -> ALL YVSOE S5007&.5 BEACOMS ¥VSOE/B iN MEMORY OF YVSLIX
19-£eb-2010 00.38=z -> ALL P43 HRIJA = VPS/sh for DHCC or Antartica???
19-£feb-2010 00.54=z -> RLL NOUM E432, KRSJA = 5. Shetlands

19-£eb-2010 00.55z -» ALL P43k NOUM, TIHNE, 73's

ECLUSTER montTor | FLTERED spoTs | Mol Ro. | wwy | messace | Talk | ann | sErue [

ANN introduces the ANNOUNCE MANAGER. In the window List Announces the transited
Announces are shown. The commands in the left side allows to select how many announces to show.
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File Log Strumenti Stampe Award Manager 7?7

/3 CLUSTER

Conn. [GBFUIS]

% Disconn. | i Pulisci | § Richieste al Cluster ~ | A Invio SpotDx || ||[€F2 - New Wbk i 40m

ANN/10 [ List Announces| New Announce |
r ard —
ANN/100 New Announce
ANN/500 ) To All Nodes Cluster [ SEND ANNOUMCE
ANMN/ 1000 i@ To Local Cluster

To send an ANNOUNCE we have to use the Section New Announce: the two radius allow to select
the destination of our Announce: Local Cluster is that one whose we are connected, so, if this option
is tagged, the Announce will be transmitted only to the people connected to the Node which we are
connected, with the option To All Nodes Clusters we will send it to all the Clusters connected in the
Web. The text of the message-announce has to be written in the proper box and with SEND
ANNOUNCE key it is sent.

UTC : 14.58.04

Freq.: 21.203 Mhz

Note :

DXCC : UNITED STATES OF AMERICA

QRB = 9673 km - Short : 319° Long @ 139°

Situation on: 15m

o] o R s ] oreer

In the SPOT WINDOW will appear only the spots filtered by the criteria we have sat in the Section
SETTINGS. A DOUBLE CLICK on the callsing appeared in RED in the window transfers al the data
(callsign, band, mode and note) in the Insert QSO Window (F2). The strip below the one showing
the DXCC Country shows the QRB and the bearing of the antenna via short path and long path.
Below that we will see our situation about that DXCC Country in the spotted band and in the various
modes. The colour code has this meaning: WHITE = not worked, - = worked, GREEN =
confirmed, YELLOW = confirmed via LoTW, CYAN = credited by the DXCC Desk.
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F6 key shows your situation about the country of the spot in the selected bands and modes. The
modes are reduced to 6 and OTHER is for all other modes than those shown.
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The Toolbar

Il BBLogger 1.0.1.3
File Llog Strumenti Stampe Award Manager ?

The Toolbar contains the menus: FILE, LOG, TOOLS, PRINTINGS, AWARD MANAGER e ?
The menu FILE opens the FILES MANAGER that allows to make operations on files in ADIF format.

Running the software for first time you could need to import your existing log from another logging
software. We assume you already created your log on BBLogger and have an ADIF file exported with
your old software. You can easily import it in BBLogger. If in your ADIF log a DXCC code is found,
the software imports the QSOs and the Country is assumed to be that recorded in your old log.
Otherwise, selecting AUTOMATIC DXCC CHECK, the software will import the QSOs with DXCC
Country sure, on the base of the internal DXCC database, and will write a secondary ADIF file
containing the QSOs with ambiguous Country ( e.g. GB, VP8, ZK1, etc. ) Later you can import this
second file but with the option MANUAL DXCC CHECK. In this way, looking at the QSL cards or to
your old log, you will be able to assign the correct Country to your QSOs. If the ADIF file does not
contain the DXCC code, the procedure of importation cannot detect the Country on the base of the
Country Name of your old log: Italy is always Italy, but Germany could be Germany, or Federal
Republic of Germany, or F.R. Germany or BRD and so on.

So it is impossible to transfer the Country from a log to BBlogger as it is.

The only way is to resolve the callsign.

Importa File > LOG | Esporta Log in File | DownLoad File LoTw/eQsl |

[7] Filtro Date Qso

Data == [Cfogf2000 ~ Options

i@ Verifica automatica DXCC Tipo File = [ABIF Log Generic v|
i Verifica manuale DXCC

Data <= 19/09/2009 ~

—

Log destinazione > | ic2uvr - L ok |

THE ARRL

' .I.?'r-ulr.:“""“'-'-’

Process | Qso not imported |

The function EXPORT LOG IN ADIF allows to export a log in ADIF format.




Also in this circumstance a date range is selectable and it is possible to copy the content of various
fields linked to the various Awards managed, for different purposes.

The function IMPORT CREDIT FILES has been contemplated to import the "Credit files" of some
Awards like DCI or DAI and sent to the users by the Managers of these Awards, to automatically
update the records of BBLogger like that happens with dedicated softwares.

[ ] Filtro Date Qso

Data >= 19/09/2009 ~

Data <= 19/09/2009 =~

THE ARRL

EXITE e £S5l

| Importa File > LOG | Esporta Log in File | DownLoad File LoTw/eQsl |

Options

["| Copia nei Commenti > [ECA = | Tipo File = [AD]]:Lngﬁene_ric vl

Origine del Log >

e)sL Comment

)

|k2uvR - | oK |

The menu LOG allows to ADD A NEW USER e.g. if you want to use your log to manage different
callsigns ( special event calls, contect calls, etc. or any callsign you manage as Manager of that
Station ), to EDIT USER ( DATA ), to CREATE NEW LOGS, OPEN THEM, MODIFY THEM,
DELETE THEM, and MAKE FILTERED LOGS: as example you could wish to extrapolate from your
log all contacts had in a determinated time, or all the contacts had with a determinated callsign, and
more. To do that, you need to select first the ORIGIN LOG and the applique the appropriate

FILTERS:

§ P
Il Log Filter
| Scefta campo Fiftro Vafore Testa
| caLLsIGN % ez |
Data == Dafa <=
[[] Range Date Qso >  17/01/1333 = 21052009 ~

Choose the field to filter and the kind of filter to applique, then enter the value in the right box.




As example you can select CALLSIGN = IK2UVR and select a range of date, e.g. 06/08/2008 -
06/09/2009 to create a new log containing only the QSOs had with IK2UVR in the selected period of
time. Also in this circumstance it is possible to apply the wild card $ ( Dollar ) to get also the callsigns
containing the selected string, like slashed calls ( IK2UVR/ISO, F/IK2UVR, and so on ). Last option is
MERGE LOG/LOG that allows to copy a log upon another log, selecting the ORIGIN LOG and the
DESTINATION LOG among those existing. There is the option DELETE ORIGIN LOG in case you
want to delete the origin log after the merging. The menu TOOLS contains the options

CONFIGURATION/MAINTENANCE ( see | Tnitial Setip” nage ) QSL MANAGER ( see | Q5L Manager |
page ), MANAGER to manage the Manager database:

| vanner o600

flid 4 |1

diG6907 | b k| | Ricercax Manager | Ricercax Call |||

Managers | Nuovo Ma nager|

Callsign Manager Valid TNFD lotes -
OM2FK YU1HA 1994 L]
050C IALF 1994
0S0C/3A2LF F&FNL 1994
050D OMIALZ 1995
0S0E DC3ME 1995
0S0YL IK2QSM 1995
0S1A T1RE] 1995
0518 T1RE] 1995
OT/AC2 WADYL 1994
0TsC TIORC 1994
OTaC TIORC 1994

L1A0KTA TOTY 1995 Chid =

It is possible to perform seeks by call and by manager. The database is updatable by the user:

% Mﬁﬁ%ﬁ%f-i 66007 = M@Eﬁp
il 4 4 |1 di 66907 | [+ ] | Ricerca x Manager | Ricercax Call | T
Nuovo Manager
Call T ]
Manager

Info

Other utilities of the menu TOOLS are: DXCC: show the content of the database DXCC. You can edit
it ( be very careful ) e.g. to insert new prefixes or new Country when elegible.
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) FILTER ON COUNTRY > >> ALL DXCC COUNTRY v

.| PREFDX LOCATOR
COUNTRY CODE |
CONT DELETED [~ I
Q ZONE VALID FROM |
1D PREF VALID UNTIL  04/07/2009 [~
ITU ZONE

ON-LINE PROPAGATION is an utility of the menu TOOLS that provides info about the propagation
predictions, on based on the present conditions of solar flux. Indispensable a web connection:

File Log Strumenti Stampe Award Manager 7?7

g CLUSTER

Conn. [GBTUIS] ¥ Disconn. | Pulisci | ¥ Richieste al Cluster ~ | A Invio SpotDx | | JAMAICA : New DXCC in 20m
GREVLINE | §pot WWV | WEB Info |
PROPAGATION
Solar-Terrestrial Data -
wwv /10 8 Feb 19 1281 UTC YHF Conditions HF Conditions
lar Fli Iten Status ET Day Hight
WWV/100 s Aurora 80n-40n  Fair Good
Aur Lat &3,9° 38m=-28m Fair Fair
¥ 2m EsEU 17n=-13n
AT = 2m E=MA 12m=-18n
AD-51 - 2 y 1| Geomag Field ¥
F ||5ig Hoise Lvl
O WWY
@ WCY

l[i:LLBTERhﬁiﬁTﬁﬁEﬁTﬁERE[}Eﬁﬁﬁ]_ﬁﬁu RQ.| wwv | MESSAGE | TALK | Ann jéﬁu"'ﬁ'—

HAM MAPS is an utility of the menu TOOLS that provides various HAM maps, with Countries, CQ
zone, ITU zone, WW Locator.
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BRARIETRGA

4K, 2L 5, CESA KCa

AWARD DATA VIEWER is an utility of the menu TOOLS that allows to view, search, and in some
circumstance edit/add the data of the various databases related to the implemented Awards.

[ Award DataViewer S B —— B

M| 4|1 di1345 | b | bl | DB > [GERMAN_DOK |+|| 3 visualizza |&f ~ | [ Nuova Ref.
REF DESCRIPTION - PREFIX COUNTRY
it : 7 |
DOK-25GYM |25 J STAEDT GYMN.B. DL GERMANY
DOK-ADUKW |40 J UKWIGEA UKWAD) DL GERMANY
DOKS0BO |50 J. 0V BOCHUM 004 oL GERMANY
DOKSOLE  [50J. 0V LUDWIG. PO6 DL GERMANY
DOK-9GFHE |40 J. FLIEG. ERDING DL GERMANY
DOK-S6TSK | TAGE D.SCHWED.K.LUET DL GERMANY
DOKS6YFD  |FD-AKTIVIT.RAUM NUER oL GERMANY
DOK-AD KONSTANZ DL GERMANY
DOKADZ  |BRUCHSAL DL GERMANY
DOK-A03 EADEN-BADEN DL GERMANY
DOK-A04 BUEHL oL GERMANY

A

QSL MANAGEMENT is an important utility of the menu TOOLS that allows to control the situation of

the QSL cards.

See M please.
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From the TOOLS Menu it is possible to launch the BBTerminal, based on MMVARI engine by
JE3HHT and the BBLCAT, based on Omnirig by VE3NEA.

The menu ? contains the icon "i" - Info on that shows the info about the Version, the icon "?" - Help
that launches this HELP written in HTML and CHECK THE UPDATES that allows to manually check

the web to see if there are updates available.

p - B .
Other menus of the Toolbar are " PHRGAGS )5 (AWard Manager) ,jease see their pages.
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Printings

This menu allows to make many kind of printings:

PRINT LOG:

This function allows to perform printings at discretion of the Log. You can print on a text file or on a
HTML file, readable with any browser, Explorer, Firefox, etc, and also in Excel (Microsoft) / Calc
(Sun). You can also print your log as a paper log, to be signed and kept in your shack for any legal

occours. It is possible to select the fields to include in the printings:

Mome del LOG :

[] Filtro Date

prova

[7] Date Ascending

Campidel Log

Date ==

27/03f2010 [E~

Date <= 27/03/2010 [El=

Campi Awards

-

[] COMMENT
[ Dxce

[] FREQ

[ U

[7] LOCATOR
[ MANAGER
] NAME

[] PROP

[ PWR

7] QrB

[ QSLr

[ BCA
[ c19p

[] CANADAWARD
[] CASHOTA

[ cea
[ cce
7] com

[ cisa
[ cora
[7] COTA_RUSSIA

[] COUNTY

Log in Bucel

Log in Html

Login Txt

Book Station

Tagging the Date Filter box you can select a date range, tagging the various managed Awards you
can add the info contained in the related dedicated areas.
Tagging Date Ascending box the log will be printed from the oldest QSO to the newest one.

Of course the criteria can be merged. The three buttons select the printing in Excel, HTML or TXT.

This is a sample of HTML printing:

Log : LB0125 09/09/2008 22.36.58

DATE

06-09-2008

[06-09-2008
06-09-2008
[06-09-2008
07-08-2008
[06-08-2008

06-08-2008

06-08-2008
|06-08-2008

TIME
1950
19.34
01.50
01.50
120.10
10.52
10.52
19.52
10.52

CALLSIGN
IK3ABYP
[K3ABY
N7GH
NSUH
HAITI
0SSW
1Z7ECB
IKSVRN
TK2WZQ

MODE
S5B
S8B
SSB
SSB
SSB
ssB
S8B
sSB
SSB

BAND RSTr RSTs
20m 59 59
2w 59 50
|20m 39 59
20m 59 50
[20m 30 59
Afhm 59 30
[40m 50 50
40im 59 29
|30m 39 59

39




This is a sample of TXT printing:

bng : L0325 09/09/2008 22.37.27

DATE TIME CATT.STGH MODE BL4ND H5Tx R5Ts
06-05-2008 i5.558 TK3RBY/P 556 Z20m a8 a8
06-05-2008 i5.34 TH3A5Y 556 Z20m a8 a8
06-05-2008 0i.50 WTGH 556 Z20m a8 a8
06-05-2008 0i.50 HaUH 556 Z20m a8 a8
0T7-08-2008 20.19 HAiTT 556 20m a8 a8
06—-08-2008 i5.52 I055W 556 40m a8 a8
06—-08-2008 15.52 IZTECE 556 40m a8 a8
06—-08-2008 15.52 THEBVEN 556 40m a8 a8
06—-08-2008 15.52 THIZWZEQ 556 40m a8 a8
06—-08-2008 15.52 TRILS 556 40m a8 a8
06—-08-2008 15.52 CHTER 556 40m a8 a8
06—-08-2008 15.52 CH3GE 556 40m a8 a8
06—-08-2008 15.52 I3BIF 556 401 a8 a8
06—-08-2008 15.52 H2UVR 556 Z20m a8 a8
06-08-2008 if.5Z2 Uaissh 556 i5m a5 a5

PRINT LABELS AND QSL CARDS:

In this section is shown how to print the labels with QSO data and the QSL cards.
First of all you must select the QSO to print.

The grid shown below contains all QSO with a "N" in the field QSLs.

You can select the QSOs one by one or all them with "Select all”.

You can also select from which log you take the QSOs: one, two, or more.

P =

=l »> The final courtesy of Q50 1= a Q5L <<

== 3% |

Qsl Buffer | Stampa Etichette |

ER rica QslBuffer rin = A
Ricarica QsiBuffi Print CALLSIGH DATAUTC MODO BANDA RST QSL_MANAGER ~
: y ANEGH 31/05/2000 13,42 |55B 17m 59 CT1EGH L
%5 Seleziona Tutto =
H : m
M3FI¥ 07,02/2004 10,25 | 558 20 59
Q50 Selezionati: 6 LIASFM 27/09/2003 8.49 |SSE 20m 59
' O Ricerca x Call RABLEP 20,03/20049.21 |55 20m 59
— 7| |UAsID 20,/03/20049.01 |55B 20m 59
= origine del Log 71 1305/2004 10,53 5B =
% Q_QQQ [ |rZ&HKM 13/03/2004 10,52 | 558 15m 59
pippo
[ 1sola [ |uasID 13/03/20049.50 |58 20m 59
IKZUVR SYBEP 13/03/20049.43 |5SB 20m 59
[ |umsLwz 13/03/20049.29 |58 20m 59
| [ |oHsgw 13/03/20049.23 |5SB 20m 59
O |1ofvo7LKw 06,/03/20049.90 |55B 40m 59
IKZvUC 28,/02/2004 10,50 | 558 40m 59
Nl |||_'| L IAGKT i nnaA g A4 | oop i oo i
o i




This window is the same for labels and QSL cards. Their number is shown in colour magenta.

Last column on the right allows to select the QSOs wherefor you want to send the QSL card via
direct.

By default all QSO are sat to Y ( send the QSL card via bureau ) but they can be manually sat to D
(send the QSL card via direct) through a menu.

Once the selection has been done, click on PRINT LABELS or QSL TEMPLATE if you are using
PRINT QSL:

I. ! >> The final courtesy,
Impostazioni di stampa Etichetta
[¥] Economy Sheet A4 297x210 mm [7] Bordi Etichetta I
Altezza 36 = i
Colonne 3 & Righe 8 & [] raggruppa Call
Larghezza 70 J [7] stampa Commenti
| Bordo Sup. 0,0 % Bordo Inf. | 00 =
Bordo Dx 0,0 £ BordoSx | 00 5
Il Spazio 0. 0,0 = SpazioV. | 0,0 = X=0 Y=23
Valori in Millimetri CfmQs0with: <HISCALL> -via MANAGER
[_Imposta Stampante | DEEENEAY I RAWD WSl AWy
1) DD-MM-YY UTC BAND RST 2Way
Salva Modello
| | 2} DD-MM-YY UTC BAND RST 2Way
Carica Modello 1) comment Pse QSL

[ |
l Stampa/Anteprima | 2) comment 73de <MYCALL>
[ |

Annulla Modifiche

|

[ — - F— — —— = — x - — ¥

This window is the "Printing Central" for labels: here all the printing parameters: label size ( green
background boxes ), number of rows and colums ( yellow background boxes ), and the distances
between the labels and the edges of the sheet with the white backgroud boxes.

The preselected size is A4. In the sample the sheet contains 24 labels (3 columns multiplied 8 rows)
but the user can set the other data. In the right lower part of the screen you can see the label you are
going to print. All elements can be modified and placed where the user wishes.

Once you found all your settings about the labels you can save your project with SAVE TEMPLATE
key to use it further.

The key LOAD TEMPLATE loads one of the saved templates, the blue key PRINTER selects the
printer to use in case you have more than one. The checkbox Economy Sheet optimize your
printings: e.g. selecting a number of labels per sheet = 24 and the labels to print are 26, the program
does not print last two labels.

Untagging the checkbox the program uses two A4 sheets, whose one of them will be partially used to
print only two labels. The boxes on the right side are: LABEL EDGES produces a printing with
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borderlines; GROUP CALLSIGNS allow to group different QSOs with same callsigns in one label;
PRINT COMMENT inserts the content of Comment field in the label: it can be useful for dx-peditions
on something else that need to print various informations on your label.

The coloured key allows to print the CALLSIGN of the recipient or the MANAGER in different
colours. With the PRINT/PREVIEW you enter to the printing preview and to the printing process:

@Q EWEEE Chiud |

Cnf Qso with : ON7RN Cnf Qso with :IK3ABY

Qso Date UTC Band Rst 2x Qso Date UTC Band Rst 2x
06-08-08 19.52 40m 59 SSB 06-09-08 19.34 20m 59 SSB
73's de IK2UVR - Pse Qsl 73's de IK2UVR - Pse Qsl

Cnf Qso with : TA1AS Cnf Qso with :IK3ABY/P

Qso Date UTC Band Rst 2x Qso Date UTC Band Rst 2x
06-08-08 19.52 40m 59 SSB 06-09-08 19.59 20m 59 SSB
73's de IK2UVR - Pse Qsl 73's de IK2UVR - Pse Qsl

If all is OK you can print your labels pressing the icon with the printer in the upper left corner.

After the printing a box will appear asking you if you want to update your log. Selecting YES the
status QSLs of that QSO turns from "N" to "Y" or "D" if the QSL card has been sent via direct.

The QSL BUFFER allows to sort any column alphabetically or vice-versa, so sorting by CALL you
can get the printing sorted by CALL.

The menu PRINT QSL CARDS allows to print QSL cards to OM or to SWL.
Similary to the label printing from the printing buffer the user has to select the QSOs to print on QSL

card.
It is possible to select the way ( bureau or direct ).
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L > > The final court

<MANAGER>
To Amateur Radio Station:

=<HISCALL>

Mtezzn BB <MYCALL>

Larghezza 1407 <FreeTexts

Max <FreeText:>
[|Raggruppacall 7 %

<FreeText> Confirming two way QS0(s):
[7] Caricamento verticale

|| [ stampa Commenti DD-MM-YYYY U.T.C.  BAND 2WAY RST  * _ |
togo> (5] (] o +
s |

[ tmposta stampante | I
L]

Stampa fAnteprima ]

Tnx fer Qso(s) - 73" de Myname Pse/Tnx QSL
Sign Here

Carica Modello |

l
( Annulla Modifiche |
I
l

Salva Modello |

o=

4

In this window the user can edit the basic template in order to create personalized models, for any
purposes. The boxes can be positioned elsewhere and the pictures can be replaced with other
pictures.

The star on the bar ( * ) can be replaced with a text and represent the content of the comment field,
printable tagging the checkbox PRINT COMMENT.

The checkbox GROUP CALLSIGNS allow to print different QSOs/HRD reports with same call /SWL
on a QSL, and the checkbox VERTICAL LOADING allows to print QSL in vertical, "Japan style".

Until 8 QSOs per horizontal QSL and 8 QSO + 8 comment rows per vertical QSL are printable.

The box Pse/Tnx QSL gets the data from the status of the QSLr field, and change consequentially: if
QSLr = "N" then the program will print Pse QSL otherwise it will print Tnx QSL. Below this box there
is another picture: <SIGN HERE> The User can replace it with a scan of his signature or with a
second custom picture. IMPORTANT: since the ver. 1.0.2.0 the settings of the templates , both
QSL and labels ones, have been changed, so, if you made some templates before, perhaps
they won’t work properly. In this case, put them in the bin and make them again from current
default templates, modifying and saving them.




QSL CUSTOM allows to print QSL cards with a pre-printed rear, positioning all QSO data in the
wished location:

=

|

Altezza
Larghezza

X Y

| ™7 >> The final courtesy of Q50 is a Q5L <<~
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To set the layout, first of all make a scan of the back of your QSL card, then load the picture with the
key Background Image.

Now double-click on the elements you want to appear on your card. The selected element will appear

on the upper left corner of the QSL card. With a right-click is possible to set the font and its size and

colour, or delete the element, and with the left button it is possible to drag and drop the element in its
location.

X and Y value will help for the line adjustment. It is possible also to insert pictures and custom texts.

Once your custom QSL is finished, you can save it and use it later.

Since the background picture is just for setting the layout, it won't be saved. Anyway it is possible to

print the QSL card with or without the background picture ( e.g. for white-back QSL cards ).




To get the background image away, just click again on the same key. Please notice that you can
choose the Band or the Frequency although the Log Sheet shows only the band, because many
printed QSL cards show the Frequency instead of the Band.

Of course the Frequency won't be exact, but approximated: 20m = 14 Mhz, 40m = 7 MHz, 10m = 28
MHz, 2m = 144 MHz and so on.

Award Manager

This section manages the Awards.
There are three options: DXCC, TOPLIST and CUSTOM AWARDS. The section DXCC AWARD
manages the DXCC AWARDS. This window will open:

Award Manager - Mycall : IK2UVR  Log ; IK2UVR = =] &2 |

Award > DXCC_MIXED - Award Calculation J Doc Application - ‘5 PrintView E Salva Configurazione
N QSUCHTBJD] Q5L AWARDED| Q5L CFHM LOTW [QSL APPLIED

DXCC MIXED T

] ANTARCTICA

] ASIA

| EUROPE

] NORTH AMERICA
|[¥] OCEANIA

|[#] SOUTH AMERICA

[] visualizza bandiere DXCC
[[] eqsL=Valide per questo Award
[7] Count Deleted Entities

I- 12mm

b — — — o == i = .

Through the menu the User can select the Award. In this example the DXCC MIXED.

Bands, modes and also the Continents are selectable ( concerning continental Awards like IOTA EU,
IOTA NA, etc.)

Caution: make these selections according with the rules of the different Awards.

The User must follow the rules of the Award in order to the bands and modes valid for that
Award.

This section wants just to help the User to filling the application form to claim the Award, that
sometimes must be done on official forms released by the Manager and with modes different
from those this program presents.

The Authors are not responsibles for application forms refused by the Managers because not
following the rules of the Award.

We always recommend the Award chasers to get any information on the rules and the kind of
the application forms before to send their documents to the Manager.
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The box "Show DXCC flags" if selected gets the flags of the DXCC Countries appearing beside the
Country Name as shown in the picture. Since to load the set of the flags a time is spent, if that slows
down your computer too much, you can deselect the tag.

Usually, with modern Dual Core processors this time can be approx 10" to 15". The box "eQSL =
valid for this Award" count also the eQSL if tagged, and the box "Count Deleted Entities" adds
the Deleted DXCC to the list.

@ Award Man_ager - M_}'F:?“ S

— = = S T = By
: IKOUVR Log : IK2UVR = @@ﬁ

Award > DXCC_MIXED - ! Award Calculation | _'] Doc Application - ;:3 PrintView n Salva Configurazione
QSLNOT CFM [ 3/ |QSL AWARDED | Q51 CFM LOTW [QSL APPLIED

Application Setting | Application List | Application Details | Application Informations | Graphics
DXCC MIXED

-
COUNTRY (396) PRX ~ BOMt 40 Mt 30 Mt 20 Mt

=] Collegati: 257 5.M.OM. 14 1ADKM | 1ADKM
| Non Collegati: 139 L >< Jervares i

| SPRATLY IS, 15
B | Confermati: 248 f i I o |

: MOMACO 34 3A2MD 38 TKEE0K P

B Non Confermati: 9 | AGALEGA & ST, BRANDON IS, 386 | '

.| Accreditati: 120 | PR TIIS i
| RooRIGLES IS, 389

E= | Non Accreditati: 128 z EQUATORIAL GUINEA b
Collegati in 80 Mt : 53 | ANNOBON IS, (PAGALL) |30

B | Mon Collegatiin 80 Mt : 34: FLI D2
CONWAY REEF D2

2| Confermatiin 80 Mt : 43 T, ——— ==

Ep| Non Confermatiin 80 Mt : 31:_:"&'_ : : 5 :
3y [TseA 3VaEE {VaET

Accreditatiin 80 Mt : 5 : : :

— | VIET NAM 3w

B | NonAccreditatiin 80 Mt:: | 3x ' 3nv04

¥ [ [ =

(@] Collegatiin 40 Mt : 84

With AWARD CALCULATION the computing starts.
This is the report. [RBl background is for Country worked but not yet confirmed,
GREEN background is for Country confirmed and

YELLOW background means confirmed via LoTW (for those who are members - see below for info)
By a left click on a callsign you can select it as APPLIED, the background turns to BURBEE if you
want to present it for credit by the DXCC Desk. When the DXCC Desk has awardes you that QSO,
you can mark it as AWARDED (the background becomes blue, as 3A2MD in the picture) with a right
click of the mouse on it: the background colour will turn to CYAN.

Since the QSO credited by the DXCC Desk could not be that one shown, there is the possibility to
change it, with a right click, otion Change Call for Credit. A box will show all QSOs elegible and the
user can choose that one the DXCC Desk has eventually credited. The situation can be exported in
Word or in Excel.
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With the DXCC, exporting in Excel the user can select a generic document or compiled as requested
by the DXCC Desk. Under the bar with the Award name there is a detailed report, general and by

band. Clicking on Confirmed a box like that will open:

Award Manager - Mycall : IK2UVR  Log : TKZUVR

=@ =

Award > DXCC_MIXED

- Award Calculation ._j Doc Application ~ ;3 PrintView H Salva Configurazione

U= LI NQSL €FM BB | QSL AWARDED | Q5L CFM LOTW | Q5L APPLIED

 Application Setting !..ﬁppﬁcaﬁun @ Application Details { Application Informations | Graphics

DXCC MIXED Collegati: 257 [ Exportin Text 57 Export in Excel !
7
®) Collegati: 257 ~ || country CALLSIGHN “
= AFGHANISTAN YA/IKIUGK/P |=
[@] Non Collegati: 139 || ALanp 1. OHOXY '
= | ALaskA KL7RA
(| Confermati: 248 ALBANIA ZA3/IK7IWX
% Non Confermati: 9 s Ll
l AMSTERDAM & ST. PAUL IS. FT5Z1
B Accreditati: 120 ANDORRA C310F
= ANGOLA D3T
| @| Mon Accreditati: 128 ANGUILLA VPZE
ANTARCTICA R1ANZ
I =
Collegati in 80 Mt : 53 ANTIGUA & BARBUDA V25WY
| e = , ARGENTINA LUSVV
||=:| NonCollegatiin 80 Mt : 34: s AT
|=.| confermatiin 80 Mt : 43 ARUBA P43DJ
- ASCENSION IS. ZDBSA
|| Non Confermatiin80Mt: || ASIATIC RUSSIA UADAGI
- AUSTRALIA VK4ZAB
| AccreditatiimBO Mt : 5 AUSTRIA AUIVIC
AZERBATIAN AKASCW
| itatii %
1 .| Non Accreditatiin B0 ME: e ERL
| .| Collegatiin 40 Mt : 84 RAHANMAS ey
B — - 2] P T EERL O P

_—— e o o e = e = e s we

S — R —

I
|
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Selecting DXCC STATUS the following box will open:
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Application Setting | Application List | Application Details | Application Informations
AWARD ?f (:;::“t}ed Applied Awarded Totalf/Current WKD CFM
VIXED 0 ' 0 120 120,120 | 258 249

0 0 o /o 1 1

0 0 {50 50,90 251 235

0 o {30 30/30 144 105

0 i i /o o i
50M 0 0 E 5/5 53 43
40M 0 0 b2 22 84 57
30M 0 0 0 /o |18 7
20M 0 0 (62 l62/62 193 166
17M 0 i 15 15/15 104 79
15M 0 0 [11 11/11 118 83
12M 0 o 4 44 |48 34
10M 0 0 121 2171 168 138
&M 0 0 o /o 0 0
M 0 0 i |ofo 0 o
CHALLENGE |0 o 120 120 785 517

First column shows the DXCC Award to be managed, the column SELECTED shows the number of
the Countries confirmed via LOTW.

About the LoTW system please see the proper Web site and download the PDF and PPT documents
that are in that web site. These virtual confirms can be tranformed into real credits even without a
paper QSL card. This is the web site: http://www.arrl.org/lotw/

BBLogger shows these LoTW confirms with a YELLOW background in the grid of the DXCC MIXED
(see first picture).

Then the user can select the QSO's to claim the credit for by a left mouse button click on the grid
then with the right mouse button selecting APPLIED. The background turns its colour to ﬂ
These QSO's, better: the number of the Countries will be transferred from the column SELECTED to
the APPLIED one.

The column AWARDED shows the number of the Countries the ARRL has credited. These credits
can be obtained through either paper QSL card or on-line through the LoTW system.

In the grid they are with a CYAN background. When the ARRL will have credited the Countries
claimend via the on-line procedure, the user can transfer them in the AWARDED column through the
key APPLIED > AWARDED which is in the upper left corner of the screen DXCC STATUS.

Please notice that LOTW is not the goal but the media: it is a system to get DXCC credits without
paper QSL's. It works to date just for DXCC and WAS, for other Awards paper QSL cards are
requested.

The TOTAL/CURRENT column contains the Credited Countries, Total and Current. Total is
comprehensive of the deleted entities and Current are just the active entities. Last two column
represent the entities DXCC worked and confirmed ( either through paper QSL card or via LoTW )
counted on the base of the info actually contained in the log.
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Please notice that the CHALLENGE Award is based on current entities only. Deleted entities are
NOT valid. Very important: start to download the adif file from LoTW only after you aligned
your credit situation with the ARRL official one, or the data shown won't be correct. It is
possible to reset all credits to zero with the small key with a triangle with a ! in the middle, who is in
the upper left corner of the frame.

The section CUSTOM AWARDS manages all Awards except those in the Section TOPLIST.

Of course to do such a computing it is mandatory that for each QSO the proper fields have been
filled, see InsertQSO.

Also the fields of old QSOs imported from other logging programs have to be filled. That can be done
selecting the QSO and re-opening it with F4 or with a right click of the mouse.

Many info can be taken from the Callbook: as example for a QSO with an italian station it can import
the province for il WAIP, for a QSO with a french station it will provide Department for DDFM and
region for DPF.

These info can be automatically loaded with Ctrl+Enter ( selected Callbook ) or Alt+Enter
(QRZ.com).

Other info are to seek through the list recallable striking the balloon with letter "i" and inserting them
with a double click on the grid. There is another way to insert info on old QSOs in an automatic way:
AWARD AUTO CHECKING: in the sample below the CANADAWARD has been selected.

Clicking on start key the program checks all QSO with canadian stations, and enters all the data
needed according with the selected Callbook.

WARNING: the routine overwrites all the info alredy recorded, so it could write incorrect data
related to the time when the QSO was made ( e.g. if the OM changed address ).

Be very careful to use this option and always check the QSL cards! Moreover, the routine
checks all QSO, so it could get your computer working long time.

There is anyway the option to make this check shorter, activating the data range option. It depends
also from the speed of your computer.

This utility contains also the procedure to transfer the references IOTA, DAI or DCI from comment
field to the proper fields in BBLogger, for logs previously imported.

3 ; ] : BB
1 Manutenzione-Configurazione Log : IK. ﬁ
| callbooks | utility | AwardAutoChecking | patabase Linker |
Scelta Award > | cANADAWARD -
Data »>= Data <= | Iniziare il controllo |
[| Filtro Date Qso > 15/11/2009 ~ 15/11/2009 ~ J
I i
CANADAWARD - Canadian Islands
Attenzione ! 'operazione ricalcola e sovrascrive gli indirizzi 2 nome operatore i

Some Awards have a graphic view of the state.

When present, click on GRAPHICS: a map with different entities will open, the meaning of the colour
is:

WHITE for not worked
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BEB for worked not yet confirmed
GREEN for confirmend and

CYAN for credited ( just for some Awards, e.g. DXCC).

(5 Award Manager - Mycall : IK2UVR Log : IK2UVR =B R
Award : |5PPA |v| Award Calculation D Document Export ~ ;._%; PrintView Salva Configurazione

Application Setting | Application List | Application Details | Application Informations | Graphics
PUWInT SPPA l'ﬁ Foom Cut l:ﬁ] Foom In l él Print l

Collegate : 112

Non Collegate : 259
|@)] confermate:77
. Non Confermate : 35
Accreditati: 0

e

= B 0

S SP-PA
T —T— b

e o

In the picture you can see the graphics for SP-PA, the Award of Polish Counties.

The map is adaptable to the resolution of your screen through the buttons Zoom In and Zoom Out,
ant it is printable with Print.

DOCUMENT EXPORT produces a standard form to claim the selected Award.

Of course for some Awards you must use the official forms, anyway this utility can be very useful to
prepare a list of QSOs to be copied or attached to the original form.

With PRINT VIEW it is possible to show and to print the grids of the Awards and SAVE SETTINGS
allows to save selected bands, modes and continents.
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() Award Manager - Mycall : IK2UVR  Log : IK2UVR =|E] 8 |

Award : DNCC - Award Calculation D Document Export ~ é PrintView Q Salva Configurazione

| Application Setting | Application List | Application Details | Application Informations
Informazioni relative all'Award DXCC

DXCC

Nazione : U.5.A.
| Sponsor : ARRL N
Manager : Award Manager ARI, Via Scarlatti 31 , T-20124 , Milano , ITALY

|
(50 validi a partiredal : 15/11f1945 I

Link Internet : hitp:/ /www.arrl.org fawards/ #dxcc

NHote Varie : wvia Award Manager ARI

L A

The Section TOPLIST AWARDS manages the classic TOPBAND, TOPLIST and TOPMODE, and
since the version 1016, the TOP SQUARES V/U/S/EHF and HF.

They provide all statistic and graphic managements on WWLocator FIELDS and WWLocator
SQUARES.

THE 84 AWARDS MANAGEABLE WITH CURRENT VERSION OF BBLOGGER:

DXCC - DX Century Club  CQDX - CQ DX Award IOTA - Islands On The Air WAZ - Worked All

Zones
. WAC - Worked All BCA - Belgian Castles C19D -
WPX - Worked all Prefixes ; Departments of
Continents Award
Uruguay
CCC - Commonwealth CDM - Certificate of the CORA - Cities Of Russia DAI - Diploma
Century Club Mediterranean Sea Award Abbazie Italiane
. DCS - Swiss Castles DCE - Spanish Castles | DCIN - Insubric
DCI - ltalian Castles Award Award Award Castles Award
DFCF - French Forts and  DDFM - French DPF - French Regions DLI - Italian Lakes
Castles Award Departments Award Award Award
DIE - Spanish Islands DIEI - Spanish Inland ~ DME - Spanish DLD - Ge”‘.‘a”
DARC Sections Aw.
Award Islands Award Communes Award (DOK)
[IA - Italian Islands IOCA - Islands of Croatia [OSA - Islands of

H26 - Swiss Cantons Award Award Award Scotland Award
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JCC - Japan Century Cities

RDA - Russian Districts
Award

POLSKA Award (Polish
Provinces)

TOPLIST

JCG - Japan Century

Guns

SPPA - Polish Counties

Award (Powiaty)
TPEA - Spanish
Provinces Award

USA-CA - U.S.A.
Counties Award

WABRA - Worked All Brazil WAIP - Worked All

(States)

WASL - Worked All Swiss
Lakes

DIFM - French Islands
Award
CANADAWARD -
Provinces/Territories of
Canada

HOLYLAND - Israelian
Squares

WASA - Worked All
Sweden Award

EURA - European Union
Regions Award

WAB ISLANDS Award

WAB OVERSEAS BOOK
HOLDERS Award

WAHUC - Worked All
HUngarian Counties

Italian Provinces
WAU - Worked All
Ukraine (Oblasts of
Ukraine)

GCOTA - German
Castles On The Air

MIA - Mediterranean
Islands Award

TOPMODE

TRA - Argentinian
Provinces Award
ARLHS - Lighthouses
Award

WAJA - Worked All Japan

(Prefectures)

GIA - German Island
Award

CASHOTA - Castles And

Stately Homes On The Air

CISA - Canadian Islands|USISL - United States'

Award

WALA - Worked All LA
(Norwegian Counties)

SCA - Swedish
Communes Award

EURA VFOA - Via
Francigena On Air
Award

WAB LARGE
SQUARES Award
WABP - Worked All
Belgian Provinces
Award

IARU R1 All Bands —
Worked Region 1 IARU

Members

Islands Award

WANCA - Worked All
Norwegian Communes
Aw.

IFFA - Italian Flora Fauna
Award

WAB SQUARES Award

WAB CHANNEL ISLAND
Award

RAAG Award - (Greek
Call Areas Award)

IARU R1 28 MHz —
Worked Region 1 IARU
Members on 10 m.

MMIL - Russian
Oblasts Award

TOPBAND

URDA - Ukrainian
Districts Award

WACE - Worked All
Chile (Call-areas)
WAS - Worked All
States (USA)

DIA - Danish Island
Award

COTA-RUSSIA -
Russian Castles

DCTI - Diploma
Castelli del Ticino

WEFF - Worked Flora
Fauna

DMI - Italian
Municipal Buildings
Award

WAB DX Award

WAB BOOK
HOLDERS Award

CCA - Croatian
Counties Award

PIP — PSK ltalian
Provinces
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QSL Manager

This section allows to keep checked the situation of the QSL's, both paper or electronic QSL cards:

@ Qs Ma;ag_ement

=|E] ;& ]

ﬁg Q5L non ricevute
' QSL non inviate
I X QSL rifiutate

|51 QSL Pending

| 4 origine del Log

(1% QSL ricevute -

- Ricerca x Call | QSL:12949

Q5L inviate -

CALLSIGN

I08PC/R

DATAUTC
|14/10/2007 8,56 | SSB

MODE BAND Q5L MANAGER

COMMENT +

[7] Filtered
[ Ten1a3
[7] Tcoaz4
[[] F_IK2UVR
IK2UVR
[ PROVA

recent or vice-versa.

Each QSO is fully editable.
Seeks by callsign are also performable.

¥
TWSEDY/P | 14/10/20078.28 |5SB ¥
IQLUM/P | 29/09/2007 13.30 | 558 | 20m [x [y
EE5KB 29/09/2007 10,32 Isss | 20m EASKE ¥ ¥
IQ1IM/P 29/09/2007 8.42 |S5B |80m X [y |
GOFIP 01/05/2007 9.48 |SSB | 20m ¥ ¥ NODSS - AS
SV13A 01/09/2007 9,42 | 556 | 20m ¥ ¥ NOO9S -A5 |
SV1BTE 01/09/20079.40 |SSB | 20m ¥ ¥ NODSE - A5 ||
EAZAG 01/09/2007 9.15 |S5B | 40m ¥ [y MOO36 - AS
SVIBTK 01/09/2007 9.13 |SS6 | 40m ¥ ¥ NOOSE -AS |
TW3FOL 01/09/20079.11 |55B | 40m Y [y MOOSE - AS
IEMVN 01/09/20079.08 |SSB |40m ¥ ¥ NODIE - AS
EASFGE 01/09/2007 8.54 | 556 | 40m ¥ [y MOO96 - AS
IZ3LEV/IV3 01/09/2007 8.54 |56 | 40m ¥ ¥ NODIE - AS
OMIFCA 01/09/2007 8.48 |SSB | 40m ¥ [y MOO096 - AS
155FU 01/05/2007 8.43 |556 | 40m ¥ ¥ NODSS - AS
IW7DZ] |01/09/2007 8.41 |S5B | 40m L |y NOOSE - AS
4 | — I I i I I l p

As shown in the picture the user can check QSL cards sent and not sent, received and not received,

rejected and pending ( via direct ), for one or more logs.

All columns can be sorted alphabetically or vice-versa, and by date from oldest QSO to the most
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SWL Mode

The SWL mode has just one peculiarity. The HRD inserting window is like in the picture:

-

E] Dati Ascolto

=[E] & )

/¥, Forza DXCC

Callinfo | 10TA | Custom Award |

| & status DXCC | 7 LookUp Qrz.com | {§) LookUp Locator

Data
TOn
CALL HRD
Banda

Modo

Info

Nome
QTH

Note

L |

16.21 = ToOff 16.22 &

28/06/2009 [~

{T1AHU In Qso = PYIEDF

(82 HRD Reverse |

I Q5L Mng Online |

50Q - QsSls M w| | QSLMnglocal |
@5 < o @]

QRB = 1657 km - Short : 249° Long : 9°

Local Station Time = 28/06/2009 17.21.24

| salva HRD (Ctrl+s) |

Carlos Alberto Pinto Mareira

Rua Pamela Loren 59, Fortaleza Ce [ Portugal ]

Locator = IMS5BKR

In the box CALL HRD of course you have to put the callsign you heard, and in the box IN QSO the
callsign of the correspondant, the station in QSO with the station heard.

Once all data have been inserted, you can save your HRD with the button SAVE HRD or with
CTRL+S.

If you have a vald HRD also with other station ( the correspondent ), just click the HRD REVERSE
key and CALL HRD and IN QSO switch.

That gives the chance to log in real time both stations and to send a QSL card to both stations.

Other features are the same.
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BB Terminal

BB Terminal is an integrated Terminal to manage the in RTTY, PSK31, FSK, MFSK and GMSK
Modes. it works on the base of the famous engine MMVARI ® created by Makoto Mori, JE3HHT. It
can be activate from the menu TOOLS selecting BBTerminal.

The BBTerminal screen will appear:

“J BBTERM |'“3 LOGGER
() SETTINGS F12 Save Qso

o MY TAGS

The Terminal can be shown alternatively to the Log Sheet. This is the Terminal appearance:

/3 LOGGER /%3 BBTERM

| Info [ setup | Fl2Save(Qso TR " 14069.5

casiGn  NARET
ERC CRTD LOTW

NAME Dick UNITED STATES OF AMERICA [NA ] - CQ [3] TTU[ 6]  QRB : 9673 Km  Short: 319° | : ——
RSQs 599 //l-'; LOGGER +'é5 BBTERM
RSQr N1RCT de IK2UVR GA Thanks for the call Dick —
BAND UR RSQ is 599 599 | Info | Setup |
s s My Name is Gigi Gigi i

rsct | EEZIM ||my QTH is Busto Arsizio in IN4510 (} SETTINGS
o bl How do U copy? BTU N1RCT de IK2UVR pse KN
— i MY TAGS
e < RX:09/02/2010 23.39.12 > = I

| 4 oPTIONS -
% T

||i¢cocg ¢ RSQ Info 3¢ My Station ¢ 73's bye bye 7'¢ De MyCall 5f UR599 %¢ RYRY ¢?

The menu bar of the Terminal contains the following options and command:

Mode: for now we can choose RTTY, PSK31, PSK63, PSK125, FSK, GMSK and MFSK16.

Band selects the band, according with those selected when we created/modified the Log.

Please notice that RTTY works always with radio sideband selector on Lower Side Band (LSB),
unregarding the band, all other digital modes work always with Upper Side Band ( USB ),
unregarding the band. Below the Callsign Box, there are three small boxes that, when lighting,
indicate that Callsign is member of EPC, CRTD and/or LOTW.

Settings opens a window to manage the Sound Card and the levels for incoming and outcoming
lines. TX COM PORT allows to select the COM port connected to the interface for digimodes.

The program allows to choose a port physically existing.

If your computer does not have COM ports, you need an USB-COM converter.

With AutoCqg Delay the user can set the delay between two transmission if the AutoCq has been
activated in some Macro ( more info later ).

The section My RSQ allows to select the report to give: 599+? gives 599 ( of course it can be
changed ) alone or with, if needed, a unvariable data, like, as example, the province: 599-VA.
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599+001 allows to send the report followed by a serial number, increased by one unit after each QSO
saving; 599+001+UTC adds the UTC also.

This way can be useful whenevere the User needs to give a report followed by some other data.
Please remember that this is not a software created to manage contests.

The key Font Rx Window allows to change font and its size in the traffic window.

Last option is the choice between either PTT on RTS or PTT on DTR:

not all the interfaces radio<>PC homemade are the same.

Some of them work with PTT on DTR ( wire number 4 of the 9 pins serial plug ), and some other use
the PTT on RTS (wire nr. 7 of the serial plug ).

If you don't know how your interface works just try both configurations and choose that one that
sends your transceiver on air when you hit the TX key of BBTerminal.

A left click on an element appeared in the traffic window will highlight it, and a right click will transfer it
into one of the boxes in the left bar.

Data can be imported into Callsign, Name, QTH, Locator and Comment boxes.

If the QSO Window ( F2) is open, the Callsign is copied also there, getting data from the callbook, if
available, and inserting them in the proper boxes. If the QSO window ( F2 ) was not open, the
Callsign can be imported later clicking on the Callsign box and hitting Enter.

BBTerminal Setting

SoundBlaster PTT ComPorts

5.B. PlayBack > | altoparlant (Realtek High | T T P

%5.B. Recording = I v]
My R5(Qs

Line Qutput  Line Input Mic Input
@ 599 + 7

= .. i
| ™) 599 + 001

1599 + 001 + UTC

I AutoCq Delay (5ec.) = i 35'{':

(e} | @ PTT On RTS
| |
o] == (7) PTT On DTR

[C] Mute [ select [0 Select
[ Font Rxwindow |

L o

Tag shows a box in which we can enter all our info, useful for exchange of data during the QSOs:




© wocron I o- )

Desciption Value

AL IK2UVE.
My NAME Gigi
Py LOCATOR. 4510
My 3TH Busto Arsizio
My AMTEMMA el 7bnd, 10 to 40 m
My RIG Kenwood T53405
My POWER. 100 W RTTY f 25 W PSK
My WEATHER. Sunny, ternp 20 ®C

B.W. means Bandwidth and the user can choose the best bandwith for his monitor. The options are
1, 2 or 3 kHz.

With Scope we can select the display options: NET ( fTx = fRx ): selected means that the TX
frequency is the same of RX frequency.

Unselected it allows to transmit and receive with a shift ( split mode ).

AutoFrequencyControl: selected allows to keep centered the operating frequency also in case of
waving of the correspondent's signal View Wave and View Waterfall show the signals as waves or
waterfalls.

TX is a key and allows to turn the TRX to transmission for a free typing. The key change its caption to
RX and if pressed again turns the TRX to RX.

Call and Name are two windows in which the user can write the Call and the Name of the
correspondent. If we notice in the traffic window a callsign we can select it with double click of the left
button of the mouse, then with the right button import it in the Call Window.

If the Insert QSO window is open, that will transfer the callsign also in the call box of the Insert QSO
window.

In the same way we can import the NAME in the proper box, and another text in the Comment box.
The last box is for the report, currently preset to 599 but it can be editable anytime.

If a callsignis present in the box Call, running the arrow of the mouse on it you will open a balloon
containing the info related to that callsign.

The bottom bar contains the Macro Keys, all them can be edited by click with the right button of the
mouse:

Formbdacro @
60 RO CR e MYCAL > HYGALL <HYCALLS psek Descpton  KeyTag  *
I My Callsign <MYCALL = H

My Mame <MYMNAME =
My RST <MYRST =
His Callsign <HISCALL = =
His Mame <HISMAME =
GAGMGE <GAGMGE =
Logged U.T.C. < JTC =
My Locator <MYLOCAT..,
My QTH <MYQTH>

Name CQCQ My Antenna <MYANTEN...
My BTG ZMYRTG: =

Name contains the caption of the button and the window is for the text to transmit.
We can use the tags in the left window of the form.
Some macros are pre-defined, some other buttons are empty. All them are fully editable.
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The two windows of the BBTerminal are for the decodifying of the received signal ( upper window )
and for the text to send ( lower window ).

It is possible to write a text or to import a text file and send them clicking on TX in the upper bar,
otherwise you can use the Macros, clicking on them with the left button of the mouse or with Ctrl+F1,
Ctrl+F2 and so on.

There are two sets of Macros. To switch from one to the other, press CTRL+SHIFT.

Also the Auto Cq function has been implemented: to use it just put the tag <AUTOCQ> before the
text. The delay in seconds can be sat from Setting as seen before. Each macro turns the radio to RX
automatically. If you wish the radio stays on TX, just add the tag <TX> at the end of the text in the
macro. BB Terminal can be opened and used at same time with other windows. F2 open the
inserting QSO window ( that will give us all the info from the callbook ) and we can save the QSO and
all its info with the proper key in the currently open log.

Saving of the QSO can be done also without to open the F2 window, just clicking F12.

If unused, we advice to close BBTerminal ( from menu Strumenti-Tools ) since it uses a large part of
the RAM and keeps the CPU working for nothing.
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Update

When connected to the web, the software will show this picture in the right lower corner of the screen.
(all writings will be in English or any other language you choosed):

BBLogger can update by itself.

BBLogger Notify Information

Muovi aggiornamenti disponibili in rete
Avviare la procedura di aggiornamento?

|| G351 e a
B, =

Strike YES and a window will open. The available updatings will be shown.
Tag the checkboxes and press DOWNLOAD.

When the download finishes, new files will be automatically installed.
When the procedure is complete a box will appear:

BELogger aggiornamenti automatici !

) Scegliere gli aggiornamenti da scaricare | Annula ]

[ Download |

Titolo aggiornamento
[l File Database disponibile per aggiornamento : DXCC

BEBloggerlpgrade I . |i

| |
H Download : DXCC.zip

Download Completato, Attendere.. aggiornamento in corso

: o — I L =

i : : ==
27 |ENGLAND i 1

r

Not just the archives, but even the executable file can self-update. In this case the software self-shuts
down. So, if you see the software shutting down don't worry: it is normal. Just start it again and it will

be updated to last version.
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Disclaimer

BBLogger © is a software created by Radio Amateurs for Radio Amateurs and SWL. It is fully FREE
and it can be downloaded and shared with other Radio Amateurs freely. No one is authorized to ask
money or some other fee for the granting of this software.

The program and the databases are anyway property of the Authors and of the ARI Section of Busto
Arsizio and cannot be modified in any way without written permission of the Authors. The Callbooks
working with BBLogger are additional elements, property of respective Authors and can be acquired
with the modalities established by their Authors.

They are NOT distributed by the ARI Section of Busto Asizio. The Authors provide this software as it
is, without formal or tacit warranties of abearance, and cannot be considered responsible for
inconveniences like malfunctions, lost of data, or any other problem related to the use of this software
or assumed to be. The program has been tested longtime, please read the introduction, anyway, like
all the softwares, could give some problems or bugs.

The users can report those problems to info@aribusto.it or through the Newsgroup, and also can
propose changes or improuvings to the software. The Authors will try, if possible, to satisfy the
reasonable claims. Since this software is absolutely FREE there are NOT hot-line or other answering
services for technical questions.

Users have to know that any report will be evaluated and considered, even if they won't receive a
direct answer to their questions.
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